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Introduction to Corporate Manager ET 

Emergent Corporate Manager ET is designed to handle the data storage, reporting and document 

assembly requirements of law firms and corporate legal departments. 

Corporate Manager ET stores the particular profiles of both Contacts and Matters and the relationships 
between them. 

Contacts are individuals, companies, government offices, courts, municipalities, joint shareholders, estate 

shareholders, family trust shareholders and trustee shareholders. Essentially, the system considers any 

entity that holds an address or requires a specially formatted signature line to be a Contact. 

Matters, on the other hand, represent the Corporations under administration in your office.  Some 

examples of what can be done in Matters include: 

 The incorporation of a newly formed company 

 Resolutions of directors and shareholders for various purposes 

 The tracking of an extra-provincial registration for an existing corporation 

Relationships are created between Contacts and Matters and once a Contact has been entered into the 

system; it can be used repeatedly for any Matter.  

Wizards contained in Corporate Manager ET will dramatically cut down on drafting and editing time, as 
well as keep your corporate information current and easy to consult. 

 

 

 

 

 

 

 

Technical Support 

If you have questions about Corporate Manager ET do not hesitate to call the Emergent Help Desk at: 

Vancouver:  778-372-0301 
Edmonton:  780-229-0237 

Calgary:  403-351-0299 
Winnipeg:  204-201-1533 

Toronto:  416-408-2833 

Ottawa:  613-691-0153 
Halifax:  902-334-1533 

Toll-free:  866-408-2833 

For Customer Service or Technical Support, dial Ext. 1 
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Chapter 1:  The Contact Card 
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Contact Data 

Information entered on the Contact Card drives every feature, function and task performed by Corporate 
Manager ET.  It is important that you complete the Contact Card with as much available information as 

possible to minimize revisions of your documents. 

This section will cover how to open existing Contacts, enter new Contacts, delete unwanted Contacts, 

and how to fill in the information required for different types of Contacts, i.e. individuals, companies, joint 

shareholders, estate shareholders, family trust shareholders and trustee shareholders. 

Opening Contacts 

Opening Contacts to view information can be done in three ways.  Depending on where you are within 

Corporate Manager ET, you may use whichever is most convenient: 

1. Double-click on the Contact’s Name.  Double-click on any Contact name wherever it appears 
within a Matter to open the Contact Card. 

2. Right-click on the Contact Name and Select Open Contact. From within the Matter, right-
click and select Open Contact to open the Contact Card. 

 

3. Open the Contact List to search for the Contact.  Click on the Contacts button on the Toolbar. 

 

When changes to a Contact need to be made, but the Matter is not open or known, search for the 
Contact in the Contact List (as shown in the Finding Contacts or Matters in Lists) and right or double-click 

the correct match to open the Contact. 
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Creating New Contacts 

The details collected for Contacts vary depending on the Type of Contact.  For example, you may want to 
collect information such as Date of Birth and Social Insurance Number for an individual, whereas this 

data would not apply to a Company Contact.  For this reason, it is very important to select the correct 
value for the Type field in each Contact Card. 

There are two ways to enter Contacts in Corporate Manager ET.  The Quick Add is preferred to avoid 

duplicating contacts. 

1. Quick Add a Contact from Within a Matter 

Corporate Manager ET allows you to enter Contacts from within a Matter itself. Throughout the Matter 

screens, you will see areas that require Contacts. These fields define Contacts such as shareholders, 
directors, officers, executors, beneficiaries, etc. 

Click on one of these blank lines to display the New Contact Wizard. 

 

Enter part of the name of the Contact you are adding and click the Search button.  As always, the less 

precise your search terms, the more results you will get.  As an example, “William” will give results for 
“William”, “Williams”, and “Williamson”.  If the name appears in the matching Contacts List, select the 

Contact and click OK to have it inserted into this Matter.   

If the Contact does not exist, click the Create New Contact button and the Quick Add New Contact 
window will appear. Enter as much as possible of the Contact’s Name information. 
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If this is a new Contact at an existing address, click on the Search Address button.  Enter the street 

name to search for, and then select the proper address from the list.  Entering the address this way will 

link the address and in future, changes in address will only have to be made to the main Contact Card.   

Note: Open the Contact Card to complete the information on the Details Tab as required. 

2. Add New Contact 

Choose File > New > New Contact 

 

This will display a new Contact Card to enter information. 

 

Click the Full Name button and the Name Details window will appear. Enter as much as of the 
Contact’s Name information as possible.   
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When all Name fields are complete, click OK to return to the Contact Card.  Please refer to the Salutation 

Section for further discussion on completing the Salutation field. 

If this Contact is a Type other than Individual, such as a Company, or Family Trust, change it now by 
selecting the dropdown menu at Contact Type and selecting the appropriate Type.   

Select the File As dropdown menu and set the File As name, which is covered in more detail later in the 

File As section. 

Salutation Field  

Certain individuals may be known by a name that is not their legal name.  For example, a person whose 

legal name is Henry Jonathon Smith may be known as Jack Smith. Mail will be addressed to Jack Smith, 
but signature lines for legal documents will contain the formal legal name. 

In this example, the Salutation field has been manually changed to Jack.  Documents generated will 

contain the full legal name, but correspondence will be addressed to “Dear Jack”. 

 

The Contact Card will look like this: 
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You will note that the Salutation does not appear on the Contact Card itself and is only visible when you 
click the Full Name button. However, the Salutation column can easily be added in the Contacts List 

where all your Contacts are displayed. 

File As 

On every Contact Card you will notice a File As field that contains all the combinations of the name 

entered in the Full Name screen for an Individual, or the entered in the Company field for any other type 
of contact. 

 

Users can manually enter or select a different File As name if the Contact generally uses a name other 
than their Full Name.   

Note:  The File As name will be the name that appears on all signature lines and documents.   

Contact Types 

When Quick Adding a Contact from the Matter screen, it is important to pay attention to the Contact 
Type.  Most often, the default Type will be Individual and if necessary, should be changed to ensure 

documents are populated correctly.  If a Contact is not an Individual or Employee, the name should be 
entered in the Company field. 

The Available Contact Types are: 

Company Any Company involved in a Matter (e.g. the corporation, shareholder). 
Companies cannot normally be directors or officers.  Complete the Signing 

Line tab with up to two names and titles.   

Employee Employees are Timekeepers, or people at the firm working on a Matter. 
The Timekeeper checked as Primary will sign correspondence, etc.   
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There are also Types for Government, Municipal or Court Contacts.  As an example, create a Contact 
Card for the Court Probate offices used by your firm for use in Estate Administration matters. 

Shareholder Variations 

All names are entered in the Company name field.  See Signing Lines Tab below for further information 
on creating these types of compound Contacts. 

Corporate 

Shareholder 

Enter the Corporation Name and set the Contact Type to Corporation.   

Estate Shareholder Enter the Estate Shareholder and set the Contact Type to Estate.  

Family Trust 

Shareholder 

Enter the Family Trust Shareholder and set the Contact Type to Family 

Trust. 

Joint Shareholders Enter the Joint Shareholders and set the Contact Type to Joint Shareholders.  

Trustee Shareholder Enter the Trustee Shareholder and set the Contact Type to Trustee. 

Once the Shareholder names, Types and addresses are complete, Save and Close the Contact Card.  
Re-open the Contact Card, click on the Signing Lines Tab, and enter the signatories in the order that 

you wish them to appear on documents.  

Contact Address 

Click on the Address button to open the Address Details.  Enter the address details, including Phone 

numbers and Effective Date on those tabs and click OK.  Effective Dates are a useful reference for 

individuals who spend time throughout the year at different addresses or for historical records. The 
Effective Date tab is found in the Address Details window that appears whenever an address is opened. 

To check if this address is already in the database, you can also click Search Address, enter part of the 

address and click Search.  Select the desired address from the Matching Addresses grid.  As you type 
address suggestions will appear and more will be available in the dropdown menu. Select the desired 

address and click OK.  If there is no matching address, enter the information manually. 

Estate The Estate involved in a Matter or when an Estate holds shares.  Complete 

the Signing Line tab with up to four Executors. 

Family Trust When a Family Trust holds shares.   Complete the Signing Line tab with up 
to four Trustees. 

Individuals Any person playing a role in a Matter (e.g. shareholder, officer, client). 

Joint Shareholders Used when two or more individuals jointly hold shares.   Complete the 

Signing Line tab with up to four names. 

Trustee Shareholder When a trustee holds shares.   Complete the Signing Line tab with the 
Trustee name. 

Our Law Firm There should only be one “Our Firm” Contact.  All Employees should 

link their address to this contact card to avoid address duplication. 
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When finished entering the address, select OK and then set the address Type.  You can have an 
unlimited number of addresses, but use a specific Type, such as mailing or registered office address, only 
once per Contact. 

Firm as a Corporation’s Registered Office Address 

When your Firm will act as the Registered Office for the company, select the Use Firm as Registered 
Address option and Corporate Manager ET will set the address Type to Registered Office.  If there are 

multiple offices, a dropdown menu will appear to choose the proper office location.  This is only available 
if the Type has been set to Company. 

 

In addition, this address will be linked so that if there is a need to change the address, all related 
addresses will automatically be updated.  

Entering Additional Addresses 

To enter an additional address, open the Contact and select the Other Addresses Tab. Click on the New 
Address or Find button and enter the address details.  When finished entering the address, select OK 

and then set the address Type.  You can have an unlimited number of addresses, but use a specific Type, 
such as mailing or head office address, only once per Contact. 



 

 
Corporate Manager ET User Guide 

 

 

14 
 

 

Note:  Effective Dates are a useful reference for individuals who spend time throughout the year at 
different addresses.  

  

Default Address 

 

The Default Address displayed on the General tab of the Contact Card is the address that will be used for 
correspondence and other documents.  If a different address should be used, click on the Other 

Addresses tab, choose the address that you want to make the new Default Address by clicking the 

Default button.  This will move the previous default address from the General Tab to the Additional 
Addresses Tab.  Note:  Only one address type can be assigned at a time.  You cannot have two mailing 
addresses. 

Details Tab 

The information required on the Details Tab depends on whether the Contact Card is playing a role in 

Corporate, Estate Planning or Estate Administration.   
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Set out below are the fields and recommended use:  
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Municipality, Region/County, 

Province 

These fields are used in Estate documents to populate certain 

paragraphs in Wills and Powers of Attorney. 

Spouse You can enter the spouse name (if any) and is a reference 
field. 

Digital Signature Navigate to a digital signature stored in your network to use in 

signature blocks of outgoing correspondence.   

Client/Corp Num: If an Individual Contact Card, this is assigned by your 
accounting program and is a reference field.  If this is a 

Company Contact Card, the incorporation number can be 
entered here. 

Former Name When the Name Change Wizard is used, the former name and 

date changed will be entered here by the Wizard. 

Resident If this box is ticked, the Director’s Consent will state “I am a 
Resident of Canada”.  If not, it will state “I am not a Resident 

of Canada” 

Occupation Some documents require the Occupation, such as Estate 
Administration Applications 

Citizen of Country Some documents require Citizenship, such as the Significant 

Control Register 

Gender Documents can be gender specific using this dropdown. 

Children This is a reference field. 

Marital Status Many Estate Administration documents require this. 

Health Number Used for Executor Services 

SIN Used for Executor Services 

License  Used for Executor Services 

License (if Lawyer/Employee) Enter the LSO number for the back page of Court documents. 

Date of Birth/Date of Death Type the name of the month (Oct, Dec, Sept) when entering 

the date to ensure proper date format. 

Edited By:, Last Edited Tracked by the Emergent program.  No changes are possible. 

Fee/Rate Fees charged to the client can be entered here and is a 
reference field. 

Inactive Tick this box to remove the Contact Card from the Active 

Contacts List. 

Signing Lines Tab 
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Create the new Contact as a Principal in a Matter or as a New Contact.  Enter the name in the Company 

field as outlined above.  The File As field will populate automatically.  When the name, address and 
phone details are complete, Save and Close the Contact Card. 

 

Reopen the Contact Card, select the Signing Line tab and complete the name and title as outlined above.  

This will then populate the signature blocks in documents. 

 

All other types are entered the same way, with the “Name” in the Company field, and the proper way to 

enter the name is displayed in the blue stripe of the Contact Card in the images below showing the 
Signing Line Tab entries.   

Family Trust (up to four Trustees): 

 

Joint Shareholders (up to four names): 
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Estate: 

 

Address Changes 

Changing an Address 

To change the address of a Contact, click on the Address button to open the address details, make the 
desired changes and click OK.   

Note:  If you are changing the Registered Office Address of a Company, see the instructions below.  Do 
NOT overwrite the existing address. 
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Changing an address on one Contact Card can change the address on ALL Contact Cards that are linked 

to that address.  If the address is used by multiple Contacts, you will get a prompt advising you that 
changing the address will change the address for all Contacts using the same address.  Note:  If the 
number on the prompt is larger than expected, cancel the process and confirm the change is 
intended for all linked addresses. Click the Links button to see all Contact Cards using that 
address.  

 

Click Yes and all Contacts using that address will change.  Click on No to change the address for only 

that Contact.   

Unlinking an Address 

 

As previously mentioned, changing an address on one Contact Card will change the address on ALL 

Contact Cards linked to that address.  Changing the address on that individual’s Contact Card will change 
the address on every individual using that address. 



 

 
Corporate Manager ET User Guide 

 

 

20 
 

 

In this case, click on the Address button to open the address form and enter the new address as above.  

Click ok and you will be asked whether this is a change to all contacts using that address or not.  Click 
No to change the address for only that Contact (as an example, a family member leaving home for their 

own apartment).  

Changing Registered Office Address 

In cases where the history of previous Registered Office Addresses is not necessary, open the Corporate 

Contact card either from the Contact List or by clicking on the Corporate name within the matter and go 
to the Other Addresses tab, highlight the old address with the mouse and use the delete key to delete 

the address.  Then click either New Address or Find to add the new Registered Office Address.  Note: 
It is of particular importance to delete the old address before adding a new address.  DO 
NOT open the address and make changes as this will change ALL linked addresses.  As an 
example, if a Corporation is changing their Registered Office from the law firm to their own 
address, overwriting the address in that Contact Card will change ALL Corporations using the 
law firm as their Registered Office. 

However, if the history is required, the following steps are recommended: 

Open the Corporate Contact Card to the Other Addresses Tab.  Set the address Type to Ex-Registered 
Address and enter the End Date. 

 

Click on New Address to open the address details and enter the new address in the appropriate fields.  
Click on the Effective Date tab to enter the appropriate date.  Click OK 
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At this point the new address will appear on the Other Addresses tab with the default type of Mailing.  
Change the Type to Registered Office. 

 

If the intended Registered Office address has already been added in Corporate Manager ET, click on the 

Find button, enter part of the address and select the address from the list then click OK.   
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To complete the process, change the Type to Registered Office and enter the Effective Start Date. 

 

Name Changes 

For corporate records management in particular, it is critical to track the historical names of corporations 
and the dates of name changes. 

NOTE:  Do not use this procedure to fix typos!  To change a typo, simply change the name in the 
Contact Card name field by clicking the Name button and Save/Close. 

Individual Name Change 

NOTE:  Do not use this procedure to fix typos!  To change a typo, click on the Name button and change 
the name in the Contact Card name field change the File As, then Save and Close. 

1. Open the Contact Card and expand until the Name Change button is available. 
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2. A new screen will appear with any shareholdings for this Contact displayed.  Enter the new name 

of the individual and the Effective Date.  If automatic share certificate numbering is activated, 
new share certificate numbers will be displayed.  Click in the New Cert. Num. field to enter or 

change the new certificate numbers. 

 

3. Click Done.  A prompt will appear asking if you wish to reissue the share certificates in the new 
name.  

4. Click No for the change to take effect without reissuing new share certificates. 

5. Click Yes and the name will be updated and all existing shareholdings will be cancelled and new 
certificates issued. 

The Details Tab in the Contact Card contains any Former Names of the individual.   

 

Be sure to confirm the File As dropdown is correct for future documents. 

Corporate Name Change 

Use Common Tasks>Corporate Name Change 

1. A new window will appear with all Shareholders for this Corporation displayed.  Change the name 

of the corporation to the new name and enter the Effective Date.   
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2. Click Done.  A prompt will appear asking if you wish to reissue the share certificates in the new 

corporate name.  
3. Click No for the change to take effect without reissuing new share certificates. 

4. Click Yes and the name will be updated and all existing shareholdings will be cancelled and new 
certificates issued. 

By clicking on the corporate name, the Contact Card will appear.  The Details Tab in the Contact Card 

contains any Former Names of the corporation.  The Name Change will be also be recorded in the 

Administration tab and is accessed by clicking the Names button.   

 

The new name is automatically updated on the General Tab of the Contact Card.  Be sure to confirm the 

File As section is correct for future documents. 

Corporate Name Change when Corporation is a Shareholder 
in Another Matter 

This is a two-step process, with the first step changing the name and shares held by the Corporation in 

other matters and the second step changing the name and certificates held by shareholders of the 
Corporation. 

1. Open the Contact Card and expand until the Name Change button is available. 
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2. A new screen will appear with any shareholdings for this Contact in other Matters displayed.  

Enter the new name of the corporation and the Effective Date.  If automatic share certificate 
numbering is activated, new share certificate numbers will be displayed.  

 

3. Click Done.  A prompt will appear asking if you wish to reissue the share certificates in the new 

name.   This is referring to the shares the contact is holding in the other Matter in Emergent.  
Click No for the change to take effect without reissuing new share certificates.  Click Yes and the 

name will be updated and all existing shareholdings will be cancelled and new certificates issued. 

 

4. The Name Change wizard will appear a second time.  Again, enter the Effective Date and click 
Done.  The prompt will reappear asking if you wish to reissue the share certificates in the new 

name.   This is referring to the shares held by the shareholders of the Corporation itself.  Click 

No for the change to take effect without reissuing new share certificates.  Click Yes and the 
name will be updated and all existing shareholdings will be cancelled and new certificates issued. 

The Details Tab in the Contact Card and the Names button on the Administration Tab contains any 

Former Names of the individual.   The Principals section of the Matter the Corporation is a shareholder of 
will now also display the new name. 
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Contact Links  

Viewing Contact Links 

Contact Links allow you to find out how any given Contact is involved with different Matters. 

From the Contact form, select the Show Links button.     

If it is not easily seen on the Contact card, then you may need to click and drag the edge of the Contact 

Card to enlarge it and see all available buttons.   

 

This will display the relationships of this Contact to all related Matters and specify the roles the Contact is 

playing in each. 

 

To open any one of these Matters, click/select the Matter name. 

Change Contact Links 

Changing links is usually used when a Timekeeper leaves the firm, and all of their Matters are to be 

transferred to another Timekeeper.  This will remove the original Timekeeper from the history of all 
matters they were associated with.  If you wish to keep the history, you may add the new Timekeeper 

and change the original to “Former”.  If a Contact has more than one role in a Matter, such as Director 

and Shareholder, then all links relating to that matter are transferred even if only one role is selected. 

To Change a Contact Link, open the Contact that you want the links removed from. 
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Select the Change Links button.  You may need to click and drag the edge of the Contact Card to 

enlarge it for all available buttons.   

 

You will see the following screen:  

 

In the Change the Links field, enter the name or partial name of the Contact the links will be 
transferred to.  Hit the Tab key to trigger the search function, then click on the dropdown arrow to see 

the results of the Name Search and select the intended recipient.  Select the Links that you want to 

move.  You can select one, all or any combination, and then click OK on the confirmation prompt.   

NOTE:  You must select one link to change, even if there is only one. 

Deleting and Combining Duplicate Contacts 

There may be occasions when Contacts have been entered more than once.  Both William Smith and Bill 

Smith may be in the database, but are in fact the same person.   

When you are ready to delete a Contact, select the Inactive tickbox on the Details Tab and then click 

the Delete button on the Contact Card.  This will ensure that this Contact will no longer appear in any 

searches. 

 

NOTE:  Corporate Manager ET will not allow you delete a Contact that is linked to Matters. 
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If you try to delete a Contact and Corporate Manager ET will not allow this, you will be prompted to view 

the Links for the Contact for existing relationships. 

 

Click Yes to show the Contact Links view where you can see all the Matters to which the Contact is 
linked.   

Open the contact you wish to keep and click into the File As field and make a slight change to the File 

As name.  You can add a character or the word “keep” to differentiate from the contact you wish to 
delete.   

 

Proceed to change the links as outlined above, but when choosing the Contact to transfer the links to, 

choose the amended contact and click OK. 

 

Once all links have been transferred from the duplicate contacts, delete the duplicates by clicking the 

delete button on either the Contact Card itself and confirming that you wish to save the changes or the 
delete button on the Contact List.  When all duplicates are deleted, change the name on the remaining 

contact back to the individual’s proper name. 
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Retrieving a Deleted Contact or Matter 

Although we talk about “deleting” a Contact Card or a Matter, it’s never really deleted.  It’s just hidden 
from sight so it doesn’t clutter up your Lists.  To get your deleted item back, click on the List and change 

the dropdown menu to show Deleted Contacts.  Open the Contact Card, go to the Details Tab and 
uncheck the Inactive box.  To retrieve a corporation, click View/Matters to open the Matters List, 

change the dropdown menu to Deleted Corporate Files and double click on the name of the 

corporation.  This opens the corporation’s main screen.  Click on the Administration/Annuals Tab and 
change the corporation’s status from Closed to Open. 

 

       

More Contact Features 

Correspondence to Contacts 

The Correspond dropdown menu located on the Contact Card gives you the option to create letters, 

envelopes, faxes and labels for the Contact directly from the Contact Card.  This feature is convenient 
when correspondence is being sent to the Client that is not a topic related to a Matter, such as an 

invitation to a firm event or a congratulatory greeting.  A Letter Shell with the current date and the 

Client’s address is generated, and you can continue with the subject line and the body of the letter. 
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Copy a Contact 

  

This feature is useful to add a new contact with the same address and other contact details, such as a 
new contact at an existing accounting firm.  Click on Copy Contact, and a Copy of Contact will open.  

Edit the contact specific fields in the usual manner and Save and Close.   

Copy a Contact’s Information 

Clicking the Copy button will copy the contact information to your clipboard to be pasted into a word 

document or email. 

Digital signatures  

Digital Signatures are administered in the Details tab.  Use the Link button to find the digital signature 

file on your network and link it to the Contact Card.   

NOTE:  You may need to adjust the image file size to have it fit properly on the document signing line. 

Social Networking 

Social networking links for Facebook, Linked In and Twitter can be entered in the Social Networking tab 

of the Contact Card. 
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Chapter 2: Incorporate and 
Organize 
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Corporation Assistants 

The Corporation Assistant are streamlined processes that allow you to incorporate and organize a 

company quickly and efficiently.  You can complete an online incorporation (in available jurisdictions) and 

create an organization package for a new company in minutes.    

Creating a New Corporate Matter 

You can create a New Corporate Matter by selecting the Add New File button: 

 

Select the type of file you wish to open.  Click on the + beside Corporation Assistant for: or 
Partnership Wizard for: to display the list of Jurisdictions.  Select the desired jurisdiction and choose 

OK.  

Incorporation Wizard (Before Incorporation) 

Corporate Manager ET speeds up the process of completing the filing by using information already 

entered into the database.  For this reason, it is important the “Our Firm” Contact be set up correctly with 
mailing address and phone number.  For supported Jurisdictions, on-line filing directly with the 

Government Ministry is available. Companies can be incorporated during regular government business 

hours using Corporate Manager ET.  Once filing is completed, the Incorporation date and Corporation 
Number will automatically be added to the Corporate Matter as well as the Articles of Incorporation 

directly from the Government Ministry.  

Begin this process by clicking the Add New File button, then clicking the + next to Corporation 
Assistant for and then selecting the jurisdiction (for demonstration purposes Ontario has been chosen) 

and OK. 

 

You will be asked if the Company has already been formed.  Choose No to begin the Corporation 
Assistant. 
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There are 4 steps to complete the incorporation. 

Step 1 – Entering a New Company 

 

This first step gathers information specific to the Company.  Choose the Type of Company that is being 

incorporated: 

 Numbered Corporation 

 Corporation Name with English Only 

 Bilingual Named Corporation 

 Corporation Name with French Only 

Legal Element 

The word “Limited”, “Limitée”, “Incorporated”, “Incorporée” or “Corporation” or the corresponding 

abbreviations “Ltd.”, “Ltée”, “Inc.” or “Corp.” shall be part of the name of every corporation – a 
corporation may be legally designated by either the full or the abbreviated form.  

For a Named Company NUANS Information will also be required, including: 

 Company Name 

 Date of NUANS Search 

 NUANS Reference Number 

The Minimum and Maximum number of directors must be defined. These are numeric values and the 

minimum number of directors must be less than the maximum number of directors. 
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The Registered Office Address of the Company is required.  You can either enter the address into the 

fields manually, or, if your firm is acting as the Registered Office, you can use the Our Firm is the 
Registered Office check-box to quickly enter the Registered Office Address Information. 

Track Billing information by entering your Reference Number and Docket Number.  This is not a required 

field. 

For most situations, a Legal Opinion is not required, however, if the name is being duplicated, Companies 
and Personal Property Security Branch policy requires that a legal opinion accompany the articles being 

filed. The legal opinion must be by an individual lawyer (not a law clerk of the firm).  If a Legal 
Opinion is required, remove the checkmark next to Legal Opinion Not Required. The Legal Opinion name 

will be entered in Step 2 of this process. 

The Filing Person is the person at the firm doing the actual filing.  The name entered here will be 

remembered and will be used the next time a filing is done.  If a different person is doing the filing, 
simply change the first and last name. 

Once Step 1 of the Corporation Assistant is complete, click Next. 

Step 2 – Entering Client Information 

Step 2 of the Corporation Assistant will ask for Incorporators, First Directors and Client Contact.  

Whenever adding a principal, first search the database to see if this Contact already exists.  Enter either 

part or all of the first name; part or the entire last name or both and click the Search button to search 
for a Contact to add the existing Contact to this corporation, or commence the New Contact Card process 

as explained previously.  If changes are required, click on the name and choose Edit.  Once complete, 

choose Save to update the information or the Contact can be deleted from this Matter. 

 

Click on any of the blue headings to add the Incorporators, Directors and Client Contact. 

The Incorporator is not necessarily a director.  You can enter more than one incorporator or move on to 

adding directors.  

Adding a First Director follows the same process as an Incorporator, with the exception of choosing a 

Company as a director.  Only individuals can be first directors.  If a Contact does not exist, select New 
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Contact and enter the name and address information for this Contact.  To speed up address entry, you 

can use the registered office address entered in Step 1 for this Contact address.   

 

The Client Contact is the primary contact of this Company.  This is usually the person who gives the 

instructions or that you correspond with at the Company.  The Client Contact is entered the same way as 
the First Director.  Search for an existing Contact or add a new one. 

Once Step 2 is complete, click Next. 

Step 3 – Create Share Classes 

 

In this step of the Corporation Assistant, the share classes are created for the Corporation.  There are 
two options for entering a share class: 

1. Create a NEW Share Class:  Select the Add button and define the class name.  The Voting 

Status defaults to Voting, the Number Authorized defaults to unlimited and the Date 
Created is the current date.  Any of the default values can be changed by the dropdown menus 

and any additional information can be entered.  Restrictions can be entered in the text box, or, if 

there are no restrictions on the share class, enter Not Applicable on the Restrictions field.  Click 
on the Template box to make this Share Class available for all future Share transactions and 

automatically assign certificate prefixes and numbering as discussed in Automatic Certificate 
Numbering.  When complete, click Save.  
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2. The other option for entering share classes is to select a class structure that already exists in the 
database.  Choose View Share Templates and you will be presented with all of the share 

classes in the database. 

 

Click on the desired class and choose Select Template.  At this point, click on Add, Edit or 
Delete to add or modify any of the existing classes and then choose Save for each class. 

Once complete, click Next to go to Step 4. 

Step 4: - Enter Provisions 
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The final step of the Corporation Assistant is to enter the Restrictions on Transfers and Other Provisions 

for the company. 

There are two ways to enter text into these fields.   

1. Type, or copy and paste the text into this field.  Once new text has been entered, the option to 
save this text as a template for other Matters in the future appears.  If you choose to save this 

text, give the template a name and choose Save as Template. 

 

This will establish the restrictions for this company, and make it available as a text template for future 

use in other corporations. 

2. The second option is to select the item from an existing saved template.  Choose Load 
Template and select the item from a saved list of templates. 
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This will place the text into the window. 

To generate a draft copy of the articles of incorporation, simply select View Draft from Step 4 of the 

Corporation Assistant. 

Click Finish to open the Matter to the Overview Tab. 

Draft Process 

Some Filings may require client approval, which may take some time for the client to provide.  In this 
case, use the draft process to complete the filing by following these steps: 

1. In Step 4 of the Incorporation Process, select View Draft to generate a draft copy of the 

articles.  If you wish to view the draft articles in word format, click No when asked if you wish to 
view the draft in the Ministry format.  Clicking yes will initiate the OnCorp log-in process and the 

.pdf will be retrieved. 

2. Choose Finish and when asked to file the Articles of Incorporation online, click No. 
3. Once approved, reopen the Matter from the Corporate List and proceed through Common 

Tasks to recommence the Incorporation process, make any necessary changes and then click 
Finish. 

Generate Articles 

You can Generate Articles to print directly from Corporate Manager ET by clicking on the Common 
Tasks button and choosing Generate Articles.  You may then follow your usual Provincial registration 

procedures.   

File Online (Ontario and Federal Filings Only)  

If the answer is Yes to filing the Articles of Incorporation online on Step 4, you then can enter your 

OnCorp login information and click Login. 

After choosing Yes on the next screen, you then can enter your OnCorp login information and click 
Login. 
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The Corporation Assistant will then review your submission for errors/omissions.  If errors are found, you 
will be returned to the Corporation Assistant, errors will be listed at the bottom of each step, and you can 

fix your errors and proceed with the filing.  Warnings can be fixed as well, but are not required to be 
fixed before submitting. 

Once all errors are corrected, the filing process will begin.  This may take a few minutes,.  Please be 

patient.  A message will appear once the filing is completed.  While waiting, you can continue to work in 
Corporate Manager ET. 

 

Once the Company has been incorporated, you will be notified of the incorporation number and that the 
process is completed. 

 

Click Continue to open the Articles of Incorporation in either Emergent or Government format. 
Corporation or select the Documents Tab and click on the Articles of Incorporation underlined in blue to 

view the filed documents. 
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Organization Wizard (After Incorporation) 

If the Incorporation Wizard was used to enter the initial information, then the next step is to open the 

existing Corporate Matter, select Common Tasks > Organize this Company.  The information 

entered using the Incorporation Wizard will already be entered in the Organization Wizard. 

If the Incorporation Wizard was not used to create the new corporate matter, then begin this process by 
clicking the Add New File button, then clicking the + next to Corporation Assistant for and then 

selecting the jurisdiction (for demonstration purposes Ontario has been chosen) and OK. 

 

You will be asked if the Company has already been formed.  Choose Yes to begin the Organization 

Assistant.   

Step 1 – Address and Corporate Information 

Click on the Corporation Name button to start the name search.  Remember, the less precise your 

search terms, the better your results.  Click on Create New Contact to add the new corporate name. 

Note: if the name is in the search results, cancel the search form AND the Organization wizard to verify 
the corporation has not already been added or started.   
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Click on the Mailing Address button and enter this company’s mailing details and phone numbers.  Click 
on the Registered Office Address to enter the details, or check Use Firm Address.  If there is more 

than one office location, set in the Office dropdown.  There is also a tickbox if the Registered Office 
Address is the same as the Mailing Address. 

Enter the Incorporation Date and Corporation Number.  The Incorporation Date will be used as a 

default in the following steps.  

Enter the Number of directors (Min, Max and Fixed), select if the Company is Private or Public and 
whether they are Profit or Non-Profit, set the Fiscal Year End and whether it is Exempt from 

Audit.  If the Fiscal Year End is not known, it can be entered later. 

 

At this point, you can also enter internal firm details, such as Client, File and/or Matter Number and 
choose the Responsible Lawyer.  The list of Responsible Lawyers is made up of all Contacts in the 

database that are already entered as Employees.  If the Lawyer is not in this list, leave the field blank 

and add the Responsible Lawyer to the Administration tab after finishing the other steps in the 
Corporation Assistant.  Once the Responsible Lawyer has been added as Timekeeper to a Matter, they 

will appear in the dropdown. 
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You can also have all documentation saved to a specified location, such as the client’s sub-directory in 

the Network.  Note:  Long file paths will not save automatically, as there is a character limit. 

Once Step 1 is complete, click Next. 

Step 2 – Appoint Directors and Officers 

 

This step adds the additional Corporate Contacts.  To Add a Director, click on the Add Director button 

to start the search process and enter the name of the Director being added.  You can add new contacts 
at this point by clicking on the Create New Contact button and following the steps outlined in the 

Entering New Contacts Section. Again, the less precise your search terms, the better the results.  If 
necessary, select whether they are a First Director.  You can also choose if this person will be the Client 

Contact, and/or any Office held by this Director using the check boxes and dropdown menu.   

 

To Add an Officer, click on the Add Officer button and enter the name of the Officer to be added. At this 

point, choose the Office Position from the dropdown list.  Choose Custom Office to activate a text box 
for the custom office title.  Check Signing Authority if this officer will sign for the Corporation. A person 

may hold more than one office at the same time, however each office will be shown separately, i.e. 
Secretary and Treasurer will be treated independently.  This will be helpful if the person resigns as 

Treasurer, but stays on as the Secretary of the Corporation.  

Following the same process, enter the Accountant and Bank, if known. 

Clicking on the  beside each of the names will give you an option to either Edit or Delete a particular 
entry in the Add Director or Add Officer section.  

Selecting Delete will remove the Contact from the corporation but will not delete the Contact from 
Corporate Manager ET.  

Once Step 2 is complete, click Next. 



 

 
Corporate Manager ET User Guide 

 

 

43 
 

Step 3 – Create Share Classes 

 

If you did not use the Incorporation Wizard to form the corporation, create a New Share Class, using the 

New Share Class button. 

Enter the name of the class and select the Voting Status from the dropdown menu.  Enter the 
Number of Shares Authorized and set the Created Date and any other attributes on the dropdown 

menus. 

This is also where the share properties are fixed and any Notes and/or Restrictions on Transfers can be 

entered.  

 

Once the share classes have been entered, then click on the buttons for 

 Business Restrictions 

 Classes and Maximum Number of Shares 

 Rights Attached to Each Class 

 Restrictions on Transfers 

 Other Provisions 

and enter any requirements for the Execution of Instruments and the Director and Shareholders Quorum 

requirements. 
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If the Incorporation Wizard was used, these sections are already in the Organization Wizard.   

You can either enter the text manually, cut & paste from a word document or select Load Templates. 

 

On the right, select the Template that you want to add and then click OK.   

Select OK again to save the details. 

The above information will be displayed (and can be revised) on the By-Laws/Jurisdictions Tab in the By-
Law/Quorum section of the Matter. 

Once Step 3 is complete, click Next. 

Step 4 – Issue Shares 

The final step of the Corporate Assistant is to issue shares.   

 

Click the Issue Shares button and select the Share class in the dropdown.  If you did not create a class 

in Step 3, cancel the Share Transaction form and go back to Step 3 to create the class. 

The Transaction Date will default to the date of incorporation.  Select an existing Contact (or add a 
new one).  Enter the Certificate Number (if auto-numbering was not used) and the Quantity.  You 

can also enter the Aggregate Price, Certificate Location and Notes if required.  After entering the 

Aggregate Price, the Price Per Share will automatically be calculated.  Similarly, entering the Price 
Per Share will automatically calculate the Aggregate Price. 

Once completed, all of your share issuances will appear in the list displayed in Step 4. 

Select the Finish button to close the Corporation Assistant and open the new Corporate record. 
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Generate Organization Package 

The final step for creating this new company is to generate the organization package.  Click on the 
Common Tasks button on the Toolbar and Generate Organization Package.  All the necessary 

minute book documents will be produced, including by-laws, resolutions, consents, subscriptions, 
registers, etc. 

If you are using custom documents, the Organization Package will be found in Create Documents > 

All Documents > Packages. 

Copy Matter 

There are two reasons this feature will be used.  One is when a client incorporates multiple times, always 
using the exact same corporate structure, and the other is when a particular corporate structure is 

needed, such as a professional corporation, but the Principals are always different. 

 

Click the Copy Matter to begin the process.  There will be a prompt confirming that you wish to copy the 
Matter.  After OK you will search the new corporate name in the usual manner. 

 

After the corporate name is created, you will be asked whether to copy the Directors, Officers and 

Principals. 

 

Yes will copy Directors, Officers, Shareholders and Share Transactions, but does NOT copy information 
specific to a corporation such as Incorporation Date and Incorporation Number, etc.   

      

You will then be prompted to enter the new Organization Date (Incorporation Date).  This will change the 

election and share transaction dates from the original Matter to the new Matter.  After the new Matter is 

created, you can either enter the new incorporation date on the By-Laws/Jurisdiction Tab, and amend the 
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information on the Administration Tab to reflect new file numbers, Minute Book Box Number, etc. or use 

the Common Tasks > Organization Wizard to enter the specific corporate information. 

No will create a Matter with only the share structure and rights and restrictions.  This is useful when a 
new Template Matter is needed as set out below.  Entering a name and date are requirements to get to 

the next step, but it can be the current date and even just a single letter in the name field. 

Template Matter 

A corporate structure that is used often, such as a certain Share Class structure, can be set as a 

Template that will then be included in the New File List.   

Either choose an existing Matter to copy as set out above without the Directors, Officers and 

Shareholders, or start the Incorporation Wizard as you would to create a matter, but only entering the 
necessary structure information in steps 1, 3 and 4 of the Wizard.  

After completing the Wizard and the “blank” matter opens, go to the Administration Tab and name your 

template in the Reference field and activate the Template check box. 

 

The Template has now been added to the New File list for firm-wide use.  Selecting the Template will 

commence the new matter process in the usual manner. 
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Chapter 3: Common Tasks 
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This is the starting point for the most common actions required to organize and maintain a company.  It 

is separated into three distinct functions.   

 General Corporate Structure 

 Share Transactions 

 Directors and Officers 

 

The Common Task feature allows you to quickly process any of these items with easy-to-use Wizards that 

simplify these steps and speed up data entry.   

Note:  All date fields in these Wizards prepopulate with the current date.  Ensure these are changed to 
the date of the transactions. 
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General Corporate Structure  

Note:  All date fields in these Wizards prepopulate with the current date.  Ensure these are changed to 
the date of the transactions. 

Incorporation/Amendment  

This task starts the Corporation Assistant for incorporations.  This Wizard should only be started from the 

Common Tasks to continue the process.  To start a new matter, start from Add New File.  Note:  Online 
Filing will be available at a future date. 

Organize this Company 

Continuing from the incorporation process, the Organization Wizard quickly gathers all of the information 

necessary to complete an Organization of a Company.  This Wizard should only be started from the 
Common Tasks to continue the process.  To start a new matter, start from Add New File. 

Clean Up the Minute Book (Ontario only) 

This feature will be available at a future date. 

Update Minute Book 

This feature will be available at a future date. 

Change Organization Date 

Change Organization Date will change all election and share creation/issuance dates.  The organizational 

documents will have the signing date changed to the chosen date as well.   

 

The Change Organization date feature will update the following Dates: 

 Election Dates of Directors 

 Election Dates of Officers 

 Share Issuance Dates 

 Share Class Creation Dates 

Note: Because changing the date has a substantial impact on data, you will only be able to change the 
date until any changes in shareholdings are made.  Once share changes occur, Corporate Manager ET will 
determine that these dates are set and will not allow this change. 
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Corporate Name Change 

The Corporate Name Change provides the same process available through the Name Changes button on 
the Contact Card.  Please see Name Changes in the Contact Card Section for further information 

regarding this feature, including steps to re-issue shares in the new Corporate name. 

Amalgamation Wizard 

This Wizard should only be started from the Common Tasks to continue the process.  To start a new 

matter, start from Add New File.  Please refer to the Amalgamation Wizard Section for in-depth 
information.   

Partnerships Wizard 

This Wizard should only be started from the Common Tasks to continue the process.  To start a new 
matter, start from Add New File.  Please refer to the Partnerships Wizard Section for in-depth 

information. 

Share Transactions 

Note:  All date fields in these Wizards prepopulate with the current date.  Ensure these are changed to 
the date of the transactions. 

Resizing Rows 

If you find the rows become difficult to read after adding a number of share transactions, put your cursor 
to the far left between any two rows until it turns into an up/down arrow and click and drag the row to 

the size you would like to view.  All the rows in the grid will automatically resize to this new height for all 
Matters. 

 

Searching and Adding Principals in the matter 

All Wizards start with the list of Principals associated with the Corporation.  When using the Search box, 

Search Below searches the current Principals.  If the name does not appear, Search all Contacts to 
search the entire Emergent database.  Once it’s established the contact is not in Emergent, then Create 

New Contact and continue the process.  All explanations below will start on the step after 

selecting/creating the Principal. 
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Issue Shares 

Select the Share Class from the dropdown.  Enter the Certificate Number (if auto-numbering is not 
being used), Date Issued and Number of Shares.  You can enter the Aggregate Price and Price 

Per Share, or let Corporate Manager ET complete the calculation of the missing item. You can continue 

to issue additional shares by selecting Save and New (this will take you back to the list of Principals) or 
choose Save to finish. 

 

Balance Forward 

The “Balance Forward” method can be used when entering information on an existing corporation 
transferring from another firm to your own firm.  Rather than recreating the entire share transaction 

history of the corporation, use the Share Issue Wizard to issue the final share transaction and in the 

Notes section of the Wizard, enter “- Balance Forward, see Minute Book for transactions prior to (date)” 
or the firm standard phrase. This can speed up data entry but will limit the available history of the 

transactions.   

Note: If the decision is made later to recreate the share transaction history, the Balance Forward and 
any subsequent transactions must be deleted first. 
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Recreating Historic Share Numbering 

As set out in the Create Share Classes section, a share prefix and automatic numbering can be created.  
If you are re-creating an already existing corporation and the certificate prefix changes through the 

history of the share class (C-1; Com-2; C-3; Common 4) you can set the final form of certificate 
numbering during the creation of the Share Class, and then uncheck the box for auto numbering in the 

Capital > Share Structure tab.  You can issue shares through the wizard using the historical prefix.  

After recreating all the historical transactions, turn auto numbering back on.  The next share 
transaction will need the certificate number input manually and auto numbering will 

continue from that number onward.  If the prefix is changed without disabling auto numbering, you 
will get a warning that the prefix doesn’t conform.  

Transferring Shares 

When using the Transfer Wizard, a list of all existing shareholders will be displayed, allowing for the 
choice of the Shareholder initiating the Transfer.  New shareholders can be added as contacts in the 

usual manner. 

 

The Transfer Form will then appear, allowing for the selection of Share Class and Transfer Date.  
Specific share certificates can also be selected for transfer if more than one exists by deselecting the 

tickbox. 

In the Transfer To section, Click to Add a New Shareholder to add recipients of the share transfer.  
If the desired Shareholder is not in the principal list, you can add the new shareholder in the usual 

manner.  Enter the Certificate Number (if automatic share certificate numbering is not set), Number 

of Shares to be transferred and Aggregate Amount.  Tab through the fields to activate Add a New 
Shareholder to the list of Transferees until all have been added.  Then click Save to complete the 

transaction.  Save and New will allow a transfer from the same principal, but allow the choice of a 
different share class. 

Note:  Do not click Save until you see the Click to Add a New Shareholder available or the transfer 
will not take effect.  
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Transfer to Treasury 

This is the only share transaction that cannot be performed through the Common Tasks/Share 

Transfer wizard.  Select the down arrow on the specific line for the share transaction to be returned to 
treasury and select Transfer to Treasury from the list.  If more than one is being returned, or if it is a 

partial Transfer to Treasury, select the most recent and start the process.  All will be returned in the one 

step, or a residual will be automatically created. 

            

Date Cancelled (Transferred or Redeemed):  Enter the date of this Transfer to Treasury transaction. 

Transfer Type:  Select the type of Transfer in the dropdown.  (Do not select Consolidation or Exchange 

as there are specific Wizards for those processes.) 

Share Conversion (Class Rename/Class Redesignation) 

This Wizard is used when there is any form of change to a Share Class, whether Name, Rights and 

Restrictions, or changing from one class to another.  This process can also be used to close the previous 
class. 
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Select the share class to be converted from the Share Class dropdown.  All the shareholders of that 

class will then be displayed.  Select the Name or Create the New Share Class and whether the old 
class should be closed. The ratio of shares to be held after the conversion can be changed such as a 

“1:3” ratio.  New Certificate Numbers can be entered if automatic numbering has not been activated.  

NOTE: The original share class must have the Convertible column checked for this feature to be 
available. 

Share Exchange (S.86) 

Unlike the Share Conversion, where an entire share class is changed, this is when a single shareholder is 
exchanging one class of shares for another.  Select the Shareholder and click OK. Choose the Share Class 

to be exchanged and the New Share Class.  You can then enter the number of shares being exchanged, 

and the number of shares being issued in the new Share Class.  This can be a partial or a full exchange.  
The original share certificate will be cancelled and the new share certificates will be issued.  Only one 

class can be exchanged at a time. 

 

Share Split 

Choose the Share Class to be split and all the shareholders of that class will then be displayed.  The 

ratio of shares to be held after the split can be changed such as a “1:3” ratio (one share for three new 
shares).  New Certificate Numbers can be entered if automatic numbering has not been activated. 
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 Ratio 

Enter the Ratio of new shares for old shares, the Wizard will perform the new shareholding calculations 

automatically. 

 Cancel or Keep Existing Certificate 

You can elect to cancel all existing certificates and issue new ones in the total number for the shareholder 

for that class, or keep existing certificates and issue new ones for the difference in the number of shares 
now held by the shareholder.  If automatic share certificate numbering is not used, also enter the new 

certificate numbers. 

Click Save and the Share Split will be processed.   New share certificates can be issued for either the 

entire new number of shares or the only the difference.   

Share Consolidation  

If a Shareholder has a number of share certificates in a share class and wishes to consolidate them into 

one certificate, select the Shareholder and click OK.  On the next screen choose the class of shares being 
consolidated and the Transaction Date and click Next to automatically generate the next share 

certificate number, then Save.   The original share certificates will be cancelled and will show in the 
transaction history as “Cancellation – Share Consolidation” and the new share certificate will be issued. 
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Beneficial Shareholders (Significant Control) 

Once shares have been issued, it may be necessary to define the Beneficial Shareholders.   This is mostly 
used for corporate shareholders, trusts, etc.  Use the Beneficial Shareholder wizard to identify the 

individual(s) controlling the Shareholder of Record.  

Step 1 – select the Shareholder of Record in the dropdown 
Step 2 – select the share transaction 

Step 3 – search for the Beneficial Owner and either select from the list or create the new contact 
card in the usual manner and click Add Selected.  Repeat until all Beneficial Owners 

have been added, then click Save & Close 

The number of shares will calculate automatically based on the number of Beneficial Owners, but can be 

manually overwritten if necessary. 

 

To edit or remove Beneficial Owner Transactions, open the wizard and select the transaction.  

Edit Share Transactions 

This feature should ONLY be used for the most basic of editing, such as to change 
shareholder, dates or certificate numbers on original share issuances.  THERE IS NO “ARE YOU 

SURE” PROMPT IN THE COURSE OF EDITING.  SAVE & CLOSE COMPLETES THE ACTION.    

There are many background calculations that occur in most share transactions and editing one but not 

others will affect the accuracy of the matters.  If changes must be made to more complex share 
transactions, delete the affected transactions and start over. 
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Select a Principal from the dropdown menu, then Step 2 – Select a Transaction, and then continue to 
- Step 3 – Edit Transaction Details. 

 

Select Save to save your edits.   

Note:  The editor will only edit one transaction at a time.  If you are editing transfers, splits, etc. you 
must edit each individual transaction.  Again, it is recommended that more complex transactions 
be deleted and done over. 

Cancel Share Transactions 

Select the down arrow for the transaction you want to Cancel and then select Cancel.  Enter the 

reason for cancellation in the Notes section. 

 

Do not use Cancel to correct a mistake in a share transaction.  If you need to remove a Share 
Issuance because of an error, delete the entire transaction using the keyboard delete method below. 
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Delete Share Transactions 

Share transactions can be deleted if a mistake was made.  Place your mouse on the line and click to 

display the arrow to the left of the transaction to highlight the row and press Delete on the keyboard. 

 

If there are related transactions to this transaction, such as a transfer, they too will be deleted.  
Corporate Manager ET will provide information about the related transactions as confirmation.  When 

Yes is selected, this transaction and most related transactions will be deleted, however review the 

remaining share transactions to ensure all are deleted before redoing the transaction. 

 

Directors and Officers 

Note:  All date fields in these Wizards prepopulate with the current date.  Ensure these are changed to 
the date of the transactions. 

Elect a Director 

To Appoint a Director, select the required Contact and choose OK or add a new contact in the usual 

manner. 
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Enter the date and choose Save 

You can also choose to add this Contact as an Officer at the same time by selecting Save and Elect 

Director as Officer, then choose the Office and Save. 

 

Resign a Director 

Select the Director from the dropdown list and complete the Date Resigned, then Save to update the 
changes.   
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Replace a Director/Global Resign 

The Resign a Director feature can Resign or Replace a Director from all or any of the corporate 
Matters that they are a director of, by selecting the Director, check the Globally Resign Director and 

click Save.   

The list of the Corporations they are a Director of will display.  Select the Corporation(s) the Director is 
resigning from.  A New Director can replace the resigning director in the selected corporations during 

the same procedure by searching for and choosing or adding as a new contact in the usual manner.  
Replacement packages can also be created at the same time for each Corporation by using the 

Automatically Create Documents tickbox. 

 

Appoint an Officer 

Selecting a Contact and then OK, will make your selection an Officer of the current Matter, or you can 

choose a Contact from the database by entering the name and clicking on Search all Contacts.  When 

Custom Office is selected in the dropdown, a text box will appear for the custom office title and Save.   

 

Resign an Officer 

Select an Officer to resign and enter the Resignation Date. 
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If this Officer is also a director, you can choose Save and Resign as Officer and Director. 

Edit Director or Officer (Ontario) 

Click in the Notes table cell and enter Edit.  This is used for changes in address, etc. 

 

Removed Director or Officer (Ontario) 

After using the Director/Officer Resignation Wizard, click in the Notes table cell and enter Remove.  

This is used if a director was appointed by mistake and must be removed from Ministry records.  The 
Removal Date is the appointed date. 
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Chapter 4: Tabs 
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Corporate Matters 

This section focuses on the data entry requirements for the Corporate Manager ET. The information 

required to define a corporate Matter is sorted into various Tabs, as shown in the screenshots. 

Following each screenshot, you will find a summary of the type of information required for each of the 
data entry tabs along with tips for data entry. 

NOTE: Corporate Manager ET does not require that all, or even any, of the data entry fields be 
completed. However, it is beneficial to enter as much information as possible and keep it updated so that 
documents and reports reflect accurate corporate records. 

Overview Tab 

 

The primary purpose of the Overview Tab is to provide a summary of the corporate structure and 
provides navigation links using the blue headings on the various sections to the Tab containing that 

information.   

Corporate Contact Information can be accessed by clicking on the Company’s name, which opens the 
company’s Contact Card while clicking on the Client Contact’s name will open their Contact Card. 

Quick links are available for Shares and Shareholders, Directors and Officers.  In addition, Registrations 

and the Locations of Corporate Records are also quick linked.  If there is more information than can be 
seen in the table, scroll bars appear. 
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Capital Tab 

The Capital Tab is where the transactional based details of the entity such as Shares and Share Structure, 

Officers, Directors, Members and Incorporators are available for reference.  Section 85 Rollovers, 

Dividends, and Bonuses are also recorded here. 

 

Note: Column headings can be reordered by clicking on the heading to highlight and a second click/hold 
to drag it to a preferred position.  You will only have to change the column order once, as it will then 
appear in this location for all Matters as your default view, even after closing and reopening Corporate 
Manager ET.  

Principals 

 

Principals are any persons, companies or other entities that hold shares, offices, directorships (or 
memberships for non-profits) within a Corporate Matter. 

Any number of Principals can be entered for a Corporate Matter. All Principals are viewed on the left side 

and the details for that Principal’s share transactions, as well as offices or directorships, etc. are displayed 
on the right side of the screen. 

Director, Officer and Shareholder transactions are done through the Common Tasks Wizards. 

Note:  If the Share Transactions table is lengthy, use the Hide Treasury and Cancelled Transactions 
tickbox to only display live Certificates. 



 

 
Corporate Manager ET User Guide 

 

 

65 
 

Ledgers & Registers 

 

Clicking through the various headings will display that information.  For the complete list of current and 
resigned principals, the appropriate Ledger can be generated using the Quick Pick dropdown. 

Significant Control displays the Voting Shareholders, along with the percentage of control and whether 

they are a registered or beneficial shareholder.  Calculations are automatic based on the total number of 

voting shares held by that shareholder. 

 

Beneficial Shareholders displays the Shareholder of Record, along with the Beneficial Shareholder, as 

well as details of share holdings. 
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Share Structure 

 

Share Structure is used to track the share structure of the Corporate Matter.  

The Issued field shows the total of actual share issuances.  This field cannot be edited. 

By default, closed share classes will be removed from view.  To see closed classes, uncheck the tickbox 

next to Hide Closed Classes. 

Should you need to edit a Share Class, eg, make it convertible, or turn automatic numbering on or off as 
discussed in Recreating Historic Share Numbering, change the necessary boxes and click Save. 

Stated Capital  

When issuing shares, Stated Capital tracks the amount paid for the shares by date.  If shares are 
returned to the Treasury, the amount paid by the Corporation is also calculated.  If an increase or 

decrease in the capital of the corporation needs to be made that is unrelated to a share transaction, click 

on the  and choose New to open the entry form. 

 

Entries on particular dates can also be edited by clicking on the .   If applicable, you will be asked if 
you wish to make a change to Capital or edit share transaction, which will open the appropriate editor.  
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Creating a New Share Class 

To create a New Share Class, click the New Share Class button. 

 

Enter the name of the class and select the Voting Status from the dropdown menu.  Enter the 

Number of Shares Authorized and set the Created Date and any other attributes on the dropdown 
menus. 

Note:  This is only used to add a NEW share class.  If any changes are being made to an existing Share 
Class, use the Conversion Wizard.  

Automatic Certificate Numbering 

When creating a new share class, place a checkmark next to Automatically Assign Certificate #’s 

and provide a prefix for the number if necessary.  Enter the EXACT prefix, including hyphen and spaces, 
as this will be recreated on your share certificates.  To use the auto-numbering feature without a prefix, 

enter a space. 

Template Share Classes 

When creating a new Share Class, it can be defined as a Template.  Once checked, it will be available as 

a Template in the Incorporation Wizard. 
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Dividends 

 

Select the Share Class and the Type of Dividend being distributed.  Enter the Amount per Share or 

the Aggregate Amount of the dividend.  It is not necessary to enter both values.  Enter the Date 
Declared and Date Paid depending on the style of Dividend Resolution.  The date of the Accountant 

Letter can be entered here for history, and can also be entered in the Annuals section.  After completing 
the Dividend resolution tick the Paid checkbox.  This will ensure that this dividend will not appear in 

future documents.   

Bonuses 

Select the Type of Bonus, enter the Amount, the Date Declared and the Date Paid either using the 

dropdown menus or typing in the information required.  Once the Bonus Resolution has been completed, 
tick the Paid checkbox.  This will ensure that this Bonus will not appear in future documents.   

 

Assets and Liabilities  

The Capital Structure Tab tracks the Assets and Liabilities of the Corporation.  These are also used in a 
Section 85 Rollover.  See Section 85 Rollover for more information about this feature.  Share transactions 

are also included in this area as some S.85 can include share for shares transactions. 

Select the Asset or Liability link, click the  on the first available line and choose New. 
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Enter the Description and Type for this item.  Select the Group, such as Building, Land Accounts, 

Other, etc.  Enter the date of the item, Quantity and Value.  Add additional notes if required. 

 

Once an item has been created, it can be transferred as described in the Section 85 Rollover section.   

Interests in Land in Ontario 

To create and track the ownership of Land in Ontario in the Capital Tab, select the Asset link, click the 

 on the first available line and choose New. 

 

Set the Type to Asset in the dropdown and select Ontario Land on the Group dropdown.  Enter the 
Property Location in the Description field and the Property Identifiers in the Notes Field.  

Ctrl+Enter will create a new line in the field.  Enter the Acquired Date and the Disposition date (if any).  
When all information has been entered, click OK.   
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It may be useful to also link the required documents to the Matter through the Add Executed 
Documents feature on the Documents Tab for convenient tracking or retrieval. 

By-Laws/Jurisdiction Tab 

Jurisdictions 

 

Information in this section relates to the specific jurisdiction of incorporation, continuation or 

amalgamation. 

The Home Jurisdiction and Legislation is normally set when adding the new file  

The Incorporation Date field will hold the Incorporation, Amalgamation, Registration or Formed Date as 

displayed in the dropdown.  Changing the dropdown to Amalgamation Date will activate a button giving 

access to further amalgamation information. 

Activity Code (Ontario) 

An Activity Code is now required on many of the updated forms.  This number can be entered on the 

Bylaws/Jurisdiction Tab, Jurisdictions link.  Enter the Activity Code number in the dropdown field.  
Note:  Be careful entering this number as once entered it will be available to all Users in Emergent.  

Typos cannot be deleted.  A short explanation can be entered in the second field.  The Activity Code 
and Industry Code columns can be added to the Corporate File List for reference. 

Activity Codes can be found at Industry codes - Canada.ca.  The link is also available through the 

Research button on the Toolbar. 

https://www.canada.ca/en/revenue-agency/services/tax/businesses/topics/sole-proprietorships-partnerships/report-business-income-expenses/industry-codes.html
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By-Law/Quorum 

This area tracks the by-laws of the corporation, Directorship details, Quorum information and section by 

section details for the Articles of Incorporation.  By clicking on the buttons you can modify the 
Restrictions and/or Provisions and add or modify Templates for the Restrictions and Provisions for future 

use in other Matters. 
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Registrations - Business Name, PPSA, Extra Provincial and 
Trademarks  

 

Registrations store the information on Business Names, PPSA, Extra Provincial and Trademark 
Registrations.  

Note:  Because renewal dates or annual reporting requirements vary from Province to Province, it is 
important to use the dropdown to select the Jurisdiction.  This will activate the calendar 
calculations for the pertinent dates based on the Jurisdiction.  Corporate Manager ET will offer to 
calculate Renewal, Expiration, Anniversary and Grace Period dates. 

Clicking on the New Registration button will open the dialogue box to enter the required registration 

information.   The process is essentially the same for all Registrations sections. 

Business Names 

 Enter the Business Name;  

 Select the Jurisdiction from the dropdown; 

 Enter or select from the calendar the Registration Date; 

 Enter or select from the calendar the Last Renewal Date (for a first registration, this can be 

the same as the Registration Date; 

 Expiry Date can be left blank to allow for the automatic calculation of the Expiry Date based 

on the Jurisdiction selected; 
 Enter the Business Number in the Registration Number (this is a required field for Ontario 

government documents); 

 Enter the Agent Name and Contact information if known and/or required. 
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PPSA Registration 

 Select the Type from the dropdown;  

 Enter all pertinent information such as Reference File No, Registration No., dates, Collateral, 

etc. 

 Click the  to start the search and selection process for the Secured Parties and Debtors 

  

Extra Provincial Registrations 

 The Corporate Name populates automatically;  

 Select the Jurisdiction from the dropdown; 
 Enter the Registration Number; 

 Enter or select from the calendar the Date (this is the EXP Registration Date); 

 Anniversary and Grace Period Dates can be left blank to allow for the automatic calculation of 

the Dates based on the Jurisdiction selected; 

 Enter the Last Filed date; 

 Enter the Agent Name and Contact information.  These are required fields for Alberta 

government documents. 
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Trademark 

 Enter the Name or Description in Trademark Description;  

 If there is a graphic, navigate to and select from the Network location; 

 Enter or select from the calendar the Registration Date  

 Enter the Registration (Serial) Number; 

 Select the Jurisdiction from the dropdown; 

 The Expiration Date can be left blank to allow for the automatic calculation of the Dates 

based on the Jurisdiction selected; 
 Enter or select from the calendar the Last Filed Date (for a first registration, this can be the 

same as the Registration Date; 

  

There is, however a slight difference in the display of the Trademark information.  If a description of the 

trademark AND a link to a graphic is created, then the Trademark grid will display the “description” as a 
link.  Click on the link to open the graphic file. 

 

Professionals 
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This section tracks the registrations required to maintain a Professional Corporation. 

To add a new Member select the  under the Name column and choose Add.  Multiple members and 
their Governing Body Registration number can be entered here.  Renewal dates should also be entered 

here to add the necessary Reminder Tasks. 

Other 

If there is a type of Registration that does now follow the standard registrations as set out, it can be 

added here.  Types can be added to the dropdown if required. 

 

Related Activities and Tasks 

After all information has been entered in a Registration, Corporate Manager ET will offer to create an 
Activity to be assigned if you click Yes and an activity form is generated.  This also begins the process of 

creating a Reminder Task. 

        

NOTE: It is important to use the dropdown to select the Jurisdiction to activate the calendars.  Corporate 
Manager ET will offer to calculate Expiration, Anniversary and Grace Period dates with the following 
message: 

 

If you respond Yes, Corporate Manager ET calculates the renewal date and will also ask if you would like 

to create a Reminder Task for that date.  For example, renewal of Business Names in Ontario must occur 

every 5 years. If a user enters a registration date of 01/Jan/2020 for a business name in Ontario, 
Corporate Manager ET will calculate the Expiration date as 01/Jan/2025. As the Renewal field is updated 
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with the new registration date, Corporate Manager ET will update the Expiry date field with the new 

expiration date. 

 

See the Workflow Section for further information on Tasks. 

Renewing Registrations 

When the time comes to renew a registration, do not click on New Registration, but rather, click on the 

edit button.  This will reopen the registration information form.  For the purpose of explanation, we will 
show the Business Names Registration form.   

 

Do not change the original Registration Date.  The Last Registration Date will now become the new 
Registration Date, most likely the original Expiry Date – in this case 7/22/2020.  Clear the original Expiry 

Date and the program will again offer to calculate the new expiry date and set reminders when ok is 
clicked. 

Administration/Annuals Tab 
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Administration 

Most of the fields in this section relate to numbers for Client, Matter and File (these can generally be 
obtained through your accounting system), or date fields with respect to the life cycle of the Matter, and 

File Status fields.  

The key data entry fields on this tab are: 

Corporation This is a Contact field. The Company Name is entered here.  

Reference Use of this field can be decided as needed.  If this matter is to be a Template for 

adding new files, the Template name can be entered in this field.  This is a 
searchable field in the Corporate List view. 

Status This drop-down menu is used for specifying the Matter Status, such as Sole 

Proprietor, Active, Dissolved, etc.  This is entirely for internal purposes and is 
effective for sorting information in Lists. 

Group To create a Group, type the name and confirm when prompted.  To associate a 

Corporation with a Group, start to type the group name and select from the 

dropdown.  The Group List can be accessed from View>Corporate>Corporate Group 

Office If the firm has multiple office locations, select the Office in the dropdown to show 

where the file is located. 

Minute Book This can be your internal numbering system for keeping track of the location of the 

minute book.  The number can be set using the Incorporation Wizard or the Add 
Corporate Records.  If there are multiple office locations, it can be specified, such as 

TOR-157, as being located in Toronto, box #157. 

File Status It is this dropdown menu that populates the Matters List, which filters Matters by 
Open, Closed, Pending, etc.  It is very important to keep this File Status current for 

proper information processing and sorting.   

 

Closing Matters/ Viewing Closed Matters 

As time progresses, certain Corporate Matters will become inactive, whether by Dissolution or the client 

taking his files elsewhere. Although you have the option of deleting Matters, you may still want to 

reference them from time to time.  

It is recommended that you flag these Inactive Matters as Closed. This way you can still reference them if 
required, but they will not clutter up your Lists of Open Matters. 

To close a corporate Matter, simply open the Matter and select Closed from the File Status dropdown 

list on the Administration Tab.  This will also stop the Emergent billing process for this particular Matter. 
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You also have the option of entering a Closed Date and a Closed File Number if your department requires 

this information. 

 

Saving Documents to Client Sub-Directory Location 

Documents that are created by Corporate Manager ET can be saved automatically into the client sub-

directory.  To set this location on the Administration Tab click the button and navigate to the sub-
directory.  It’s a good idea to create an “Emergent Drafts” sub-folder for the generated documents.  

Thereafter, the document can be acessed either through Corporate Manager ET or by navigating directly 
to the client sub-directory folder. 

  

Internal Staff/Timekeepers 

 

The purpose of Timekeeper is to enter the Contacts that are responsible for the corporate Matter within 

the firm. 

This includes Lawyers, Law Clerks, Assistants, Billing Lawyers, Originating Lawyers, etc.  Roles may be 

added specific to your firm depending on document requirements. 
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NOTE:  It is important that at least one Timekeeper be entered on each corporate Matter and set to 
Primary using the tickbox.  The tickbox is used to populate the signature blocks of outgoing 
correspondence, as well as for filtering in Lists. 

Client Contact, Accountant/Auditor, Banks and Records 
Keeper 

 

These are contacts that play a role in the corporation, but are not necessarily principals. This includes 

Client Contacts (who may or may not be Principals within the company), Banks, Accountants or Auditors 
and Records Keeper.  Contacts in these sections are added in the usual manner. 

NOTE: It is important that at least one Client Contact be entered for the corporation.  If there are 
multiple Contacts, one of these Contacts must be ticked as the Primary Contact. This is the person to 
whom correspondence will be addressed.  

Annuals/Activities 

 

The Annuals Section records the information necessary to create Annual Documents.  The most recent 
Accountants Letter date can also be recorded.  In jurisdictions where yearly reporting to government is 

not required, many law firms use the Last Annuals Filed date to represent the date the annual 

resolutions were prepared or filed in the minute book. 

Last Annuals Filed Use this field to record the last date the Annual documents were 
completed and filed.  Depending on Jurisdiction this will be based on 

Incorporation Date or Fiscal Year End.  This column can be added to the 
Corporate File List and used to filter for due dates. 
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Next Annuals Due Date Date the next Annual documents must be filed. Depending on 

Jurisdiction this will be based on Incorporation Date or Fiscal Year End.  
This column can be added to the Corporate File List and used to filter for 

due dates.  When the date is altered, Corporate Manager ET offers to 
create a Reminder Task. 

Notice of Change and 

Initial Return 

Date Initial Return or Notice of Change Forms were sent to the 

respective Ministry or done by online filing (if available) are recorded 

here.  The dates in these fields control the director and officer changes 
for the next Notice of Change to be filed. 

Exempt from Audit When the Exempt from Audit checkbox is checked, then the 

corporation is exempt from audit and the corporation has Accountants, 
or if the Exempt from Audit checkbox is not checked, then the 

corporation has Auditors.  The appropriate resolutions are generated for 
the organizational documents and subsequent Annuals.  The appropriate 

Exempt from Audit provisions under the Act the company was 

incorporated under are also automatically recorded. 

Last Annual Meeting Re Enter the subject of the last annual meeting. 

Last Annual Meeting Enter the date of the last annual meeting. 

Annual Filing Fee Can be recorded as reference. 

Document Preparation Dropdown can be used to indicate whether to contact lawyer prior to 

commencing work, or other information. 

View Dates Button Dates and reasons for Articles of Amendment can be entered here. 

Activities 

Events in the management of a corporation can be processed through Activities.  From file creation to 

annuals production or Business Name Registrations, each activity can be tracked by activity type, clerk or 
any other item in the Activities List.   

Add an Activity 

Activities are added while creating Registrations, or can be added by selecting the dropdown menu under 
the Transaction Type column.  Activities can be edited or removed from this list depending on the 

selection from the dropdown menu. 
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Activity Types can be edited or removed from this list by Tools > Options > Data Maintenance > 

Corporate > Activity Transaction Type.  

Creating and Using Groups  

 

Groups can be created to track related matters, such as parent and subsidiaries, or all Matters connected 

to the same Client.   

For example, let’s assume you have five individual Corporation Matters within the program. You want to 
link all of these Matters because all five corporations are subsidiaries of a corporation called Celtic 

Connections Inc. 

In this case you would create a group called Celtic Connections.  To do this, simply type in the name of 
the group you want to add. If the group does not already exist, Corporate Manager ET will add it as a 

new group. 

Now open each of the five individual corporate Matters and add this group to them by typing Celtic. in 
the Group field and selecting it from the dropdown menu. 

To see the Groups a Corporation is associated with, open the Group List through View > Corporate > 

Groups and filter using the group field to create a listing of those corporate Matters contained within the 
desired group. 

  

 

NOTE: A Corporation can be assigned to many groups. 
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Workflow Tab 

Tasks and events are recorded here.  If used to its full potential, the result is Tasks, Client Instructions 

and Location of Corporate Records/Items are held in a single location for the Matter. 

Documents Out for Signing 

Corporate Manager ET can track documents sent to client for signing, confirmation when the signed 

document has been returned and can create a follow up letter. 

 

The follow-up task for documents sent for signing must be turned on to automatically track the 
document.  Select Create Document and Options.  Place a checkmark next to Add Follow Up Task.  

When this option is checked, all documents created will be tracked for follow up by adding a task to the 

Corporate Workflow Tab. 

 

To turn this feature off, remove the checkmark from Add Follow Up Task. 

Once the signed document has been received, use the Completed tickbox to this will remove the item 

from the list and the accompanying task will be set to completed. 

For documents that have not been returned, Create A Follow Up Letter to remind your client of the 
outstanding documents.  Documents that have been checked as returned will not be included in the 

follow up letter. 
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When a document is generated by the Wizard, it also creates a Task.  The due date of the Task is two 

months after the document has been sent to your client.  To change the due date, edit the Task and 
insert the new due date. 

 

This Task will also appear on the Reminder Report and the Task List that this document must be returned 

by the client. 

Location of Corporate Records 

Corporate Records are tracked by Item, Location and, for firms with multiple offices, the Office where the 

record is kept. To Add a Corporate Record, select the Add Corporate Records button.  

Note:  This option of adding a Corporate Record will also be available when issuing a share certificate. 
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Company Key (Ontario) 

On the Workflow Tab/Location of Corporate Records and click the Add Corporate Record 

button.  Select Company Key in the Item dropdown.  Enter the Company Key Number in the Number 

Suffix field. 

 

New Values for Item and Location can be added through Tools > Data Maintenance > Corporate.  
For Multiple offices, Offices can be added in Office/Municipality/Region under Matter. 

Items can be added to the Corporate Records by selecting the Add Corporate Records button.  They 

can be edited or deleted by selecting the option from the  in the Item Column. 

 

When adding the Minute Book, Corporate Manager ET can automatically generate the next available 
number for that Minute Book. This is can be your internal number for tracking or the minute book box 

number. 

Phone Log 
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Track all phone calls associated with this Matter, including the date, start time and duration of the call, as 

well as details of the discussion. The Add a Phone Call button will begin the timer.  Press Save when 
the call finishes and update the subject and details.  Press OK to save the information to the log. 

Remove or edit a phone call by selecting the  beside the date. 

Email 

 

If Outlook Integration is enabled, Corporate Manager ET stores emails to/from your client under their 
appropriate Matter, making it easier to see all communication to/from your client regarding that Matter.  

Even historical emails that were removed from your mailbox will continue to be available. 

Tasks 

Tasks can be created and assigned to users, and will populate the Reminder Reports and the 

Tasks/Reminders List.  Similar to Follow-up Tasks, these can also be created automatically with document 
creation, or created separately.  

 

To add a new task, click on the Add a Task button and enter the necessary information, such as Due 

Date and Priority.  Tasks can be assigned to a particular person by using the Assigned To dropdown, 
and if necessary, clicking the Action link will display the Create Document form so that the required 

document can be selected.  If the Add Follow Up Task tickbox is selected, the task will appear on the 
Follow-Up section of the Workflow tab.  
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Notes 

 

The Notes Tab allows users to enter special notes relating to the corporation.  Simply click on the next 
blank line and start typing the information to be contained in your Note.  Check the Include on CIS 

checkbox if you want a particular note to print on the Corporate Information Sheet.  

If you want to call attention to a specific note, check the Popup box. Once checked, this note will pop up 
like a yellow “sticky note” each time the file is opened until this box is unchecked. You can change the 

colour of your notes by clicking on the push pin and selecting Background Colour.  There is no limit on 
the length or number of notes that can be created. 
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Documents Tab 

 

The Documents Tab displays the link to any document related to the Matter and makes it immediately 

available to all Users of Corporate Manager ET.  Thereafter, the document can be acessed either through 
Corporate Manager ET or by navigating to the client sub-directory.  The display defaults to All 

Documents Chronologically.   

Add a Document Link 

The Add Executed Document button will launch the form to collect information needed to link Word, 

Excel, or PDF documents to the Documents Tab.   

 

Scan and save the document to the sub-directory in the usual manner; 

On the Documents Tab click on Add Document and fill out the required information, such as 
description, date and any details; 

Lastly, identify the Minute Book tab and group that the document is related to; 

Click ok to finish. 

The document will now be available for viewing by anyone with access to Corporate Manager ET or the 

Legal Kiosktm(v2).   
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Deleting a Document Link 

If a document needs deleted from the Document Tab, simply click on  and choose Delete.  Click on 
Yes to delete the hyperlink to the document.  The next prompt will give the option of deleting the 

document file itself.  ONLY CHOOSE YES TO THIS PROMPT IF YOU WANT THE DOCUMENT DELETED 

FROM YOUR SYSTEM COMPLETELY. 

NOTE:  Choosing to delete the document file will completely remove the file.  It will not go to 
a recycle bin.  If the document is deleted in error, your IT department will have to try to 
recover it. 
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Chapter 5:  Amalgamation, 
Partnership, Section 85 
Rollover 
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Amalgamation Wizard 

The Amalgamation Wizard is used to combine two or more corporations (“PreCo”).  This 7-step process 
gathers the necessary information for the new Company (“NewCo”). If the Amalgamation Wizard was 

started accidentally, cancel at this point and a new file will not be created.   

Always start the process by selecting Add New File > Corporate > Amalgamation Wizard and ok.  
This protects the history of the amalcos, including previously amalgamated corporate information. 

 

It may be necessary to Save & Close the Wizard during the Amalgamation process.  In that case, the 
Draft NewCo will be found in the Corporate File list while the pre-amalgamation corporations will be 

available under Pending Amalgamations.  To recommence the process, open any of the PreCos and use 
Common Tasks. 

 

Step 1 of the Wizard, search for the PreCos and select until all are added to the list. 

s  

Once all the PreCos have been selected, further entries, such as: 

1. Date of Amalgamation; 

2. Select the corporate structure being used; 

3. If a new name is being used, the name and NUANS information; 
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4. Type of amalgamation – Short or Long, Horizontal or Vertical 

  

Note:  The remaining steps will use the information in the Matter selected for Capital Structure 
in Step 1. 

Step 2 enter the following information: 

1. Registered Office Address.  If there are no changes to the Registered Office, DO NOT make any 

changes to the information.  If the firm is remaining as the Registered Office, DO NOT select the 
Use Firm Address tickbox- this will “break” the RO association. 

2. The Client, File and Matter numbers as assigned by accounting; 
3. The Fiscal Year End. 
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Step 3 select the Director and Officers for the Newco using the tickboxes.  New principals can be added 

by searching in the usual manner.  Office types can be changed on the dropdowns. 

 

Step 4 is related to the share structure of the Newco.  The available share classes are determined in 
Step 1 by selecting the capital structure to be used.  This also dictates the shareholders appearing on the 

Share Transactions table. 

Share Classes can be added, edited or removed in a Long Form Amalgamation, but no changes to 
share structure can be made in a Short Form Amalgamation. 

Shares can be issued to shareholders that are not contained in this list in the usual manner.  New Share 

Certificate numbers can be added during this step.  If the number of shares of the Newco differs from the 
PreCo shares, the shareholder must be removed and the new number of shares issued. 

Short Form Amalgamation 
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Long Form Amalgamation 

 

Step 5 of the Wizard is for adding or selecting the Client Contact at the Company and your firm 
Timekeepers on the Matter. 

 

Step 6 provides the opportunity to select Extra-Provincial Registrations, Business Name Registrations, 

Trademark Registrations and Other Registrations that will be retained by the Newco. 
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The Final Step asks for the effective date of the amalgamation and will print an Amalgamation 
Summary and, if chosen, Generate Amalgamation Packages for all predecessor companies and 

continue on with the organization of the Company. 

 

 

Once the Wizard is complete, an Amalgamation Summary will be created for review. If acceptable, select 
Yes to the confirmation message to complete the amalgamation. No will exit the Wizard and it can be 

activated again by clicking on the Common Tasks button to make any required changes. 
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The final result of using the Amalgamation Wizard is that the PreCo records are set to closed and popup 

notes are created with the amalgamation information as reference.  The Newco is created as a new 
matter and a popup note is also created with the amalgamation information for reference.  

      

On the By-Laws Tab, the dropdown displays the Amalgamation Date, with an Amalgamation Info 
button.  Clicking this button on a preamalco will display the Newco information and from the Newco, will 

display the PreCo information.  The matters can be opened for reference from this screen. 
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Notes: 

1. Always start the amalgamation process from Add New File;  
2. Save & Exit button allows completing the process later;   
3. Restart the Amalgamation Wizard from the Common Tasks of a PreCo. 

Amalgamated Corporation as Shareholder in Another Matter 

If the newly amalgamated corporation is a Shareholder in another Matter in Corporate Manager ET, the 
new corporation will be visible in the Principals List – no further steps need to be taken. 

Amalgamations, once completed, cannot be undone. 

Partnerships Wizard 

An easy-to-use wizard guides you through the Partnership formation process. The first step gathers 
information concerning the new entity, including the name and address of the partnership. If the 
Partnership Wizard was started accidentally, cancel at this point and a new file will not be created. 

 

Step 2 of the wizard allows for the Addition of Partners and Officers of the Partnership. 
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Step 3 involves the inclusion of the Client Contact at the Partnership and Managers and Executive 

Committee Members.  Executive Committee Members are Managers that have the Executive checkbox 
checked. 

 

Step 4 allows for the creation of Unit Classes and the Issuance of Units. 
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Note:  Even if no Units are being issued, it may be useful to create a Unit Class limited to 100 shares and 
issue them to reflect partnership percentages.  Units can then be transferred for the purposes of 
documentation, etc. 

The Final Step of the process allows for the setup of Capital Contributions and Partnership Interest 

as well as Generating a Partnership Package.   

 

Section 85 Rollover 

Rollovers can include the sale of assets or shares in the vendor company for a promissory note or shares 

from the purchaser. 

There are different types of Rollovers that can be processed:   

 Assets for Shares/Promissory Note 

 Shares for Shares/Promissory Note 

 Part of Estate Freeze Process (S.85/S.86) 

To begin the process, two Corporate Matters must be in Emergent Corporate Manager – the Vendor and 

the Purchaser.   

Creating a Sole Proprietor Vendor 

If an individual is transferring assets to a purchasing corporation, the “Vendor” must be a Sole Proprietor.  
To start the process of adding a new Matter to Emergent Corporate Manager, add a temporary name 
(this can even be a single letter) and enter an incorporation date to click through steps 2 – 4 of the 

Organization Wizard.  Although a name and incorporation date are mandatory fields, there is no need to 
add Directors, Officers, Share classes, etc.  After the final step of the Organization Wizard, change the 

Vendor Corporate Status to Sole Proprietor by setting the Status of this Matter to Sole Proprietor on 

the Administration/Annuals Tab. 
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You will then be prompted to search for the name of the Sole Proprietor.  Click ok to select an existing 

Individual Contact or add a new Contact in the usual manner, and confirm ok at the prompt. 

 

Entering Assets and Liabilities 

Click on the Capital Tab, Assets or Liabilities sections and enter the assets and/or liabilities owned by 

the Vendor as described in the Assets, Liabilities section above. 

Assets and Liabilities for Shares/Promissory Note 

Switch to the Section 85 section on the Capital Tab and select any Asset to be transferred and select 

New transaction on the dropdown menu to start the Rollover Wizard. 

 

Select the Vendor in the dropdown.  In the case of an asset rollover, the Vendor will be the Sole 
Proprietor.  Original Value and Purchase Price will display automatically.   

Note:  Items that have no Quantity or Purchase Price entered will not be transferred. 

Select the tickboxes for Transfer for Shares, and/or a Promissory Note.  You can create a new Share 

Class in the Purchasing Corporation or select a class of shares to issue.  Issue the number of shares and 
enter the Certificate Number.  It is also possible to view any used certificate numbers for this class.  

If a Promissory Note is part of the transaction, enter the amount. 

The Vendor can also be added as a Director in the Purchasing Corporation. 
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The results of this transaction are: 

 The Vendor will no longer hold the Assets;   
 The Assets of the Vendor will be transferred to the Purchaser; 

 If a Promissory Note was given as part of the transaction, it will show as an Asset in the 

Vendor Matter and a Liability in the Purchasing Corporation; 

 The Vendor will become a Shareholder in the Purchasing Company; 

 If Add Vendor as Director was checked, the Vendor will become a Director of the 

Company elected as of the Transaction Date.  

Shares for Shares/Promissory Note 

Corporate Manager ET will also process a Rollover of Shares by a Principal from one Company to another 

Company.  To complete this transaction, a Principal must exist in a Corporation (Not Sole Proprietor) and 

hold shares of that Company.   

Switch to the Section 85 section on the Capital Tab, select any Asset to be transferred and select New 
transaction on the dropdown menu to start the Rollover Wizard. 

      

Enter the number of shares and Purchase Price of the Shares being rolled over to the Purchasing 

Corporation.  If there are residual shares, enter the Residual Certificate Number. 
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Select the tickboxes for transfer for Shares, and/or a Promissory Note.  You can create a new Share Class 

in the Purchasing Corporation or select a class of shares to issue.  Issue the number of shares and enter 
the Certificate Number.  It is also possible to view any used certificate numbers for this class.  

If a Promissory Note is part of the transaction, enter the amount. 

The Vendor can also be added as a Director in the Purchasing Corporation. 

The results of this transaction are: 

 If there are residual shares, the Vendor will remain a shareholder in the originating company.  

 If a Promissory Note was given as part of the transaction, it will show as an Asset in the 

Vendor Matter and a Liability in the Purchasing Corporation 

 The Vendor will become a Shareholder in the Purchasing Company. 

 If Add Vendor as Director was checked, the Vendor will become a Director of the 
Company elected as of the transaction date.  

Combination S.85/S.86 Share Exchange/Estate Freeze 

There are a number of steps in this process, starting with both Corporate Matters must be entered in 
Corporate Manager ET. 

 Perform the S.85 as set out in Shares for Shares above 

 Issue Shares in the Originating Corporation to the Purchasing Corporation 

 Exchange the Shares held by the Originating Corporation using the Common 

Tasks/Exchange Wizard 

Deleting Rollover Transactions (Returning to 
Original in Case of Error) 

If a Section 85 transfer needs to be deleted because of a mistake or typing error, it is important to 

remove the history of the entire transaction in both Matters. 

For a Shares for Shares transaction, open the Principal tab of the Originating Vendor.   

Select the transaction row so that it is highlighted.  Ensure that this will be the row where the quantity is 
in brackets ().  Delete the transaction of the transfer.  The most effective way to delete this entry is to 

select the entire row by highlighting with your mouse and press Delete on the keyboard.  Click Yes to 
the confirmation message.  If there are any residual shares, they will need to be deleted also.  This will 

return the shareholders to their original holdings.  Delete the Purchaser Company from the Principal list.  

In the Section 85 tab, delete the transferred transaction.  Select the row where there is a quantity 
transferred and press Delete on the keyboard.  In the Purchasing Company, Delete the Vendor from 

the Principal list by selecting the Vendor and choosing Delete on the keyboard. 

 

For Asset Transactions, delete the “cancelled” entries in the Section 85 tables from the Vendor Company.   

The Assets and Liabilities will need further editing to remove the Disposition dates and Notes to return to 
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the original Asset.  The Transferred Assets will also need to be deleted from the Assets Tables in the 

Purchaser Company.   

 

If the Vendor was set as a director in the Purchaser’s Company, the Vendor will need to be deleted from 

the Principal list of the Purchaser’s company. 
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Chapter 6:  Documents and 
Reports 
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Generating Documents/Reports 

All documents from Corporate Manager ET are generated as Word documents.  

Documents  

Click on the Create Document button while in the open matter. 

 

You will then be able to access the most commonly used documents.  Click on All Documents to access 
the rest of the documents provided by Emergent.   

 

Documents are grouped into folders on the left of the Document window. Select a folder and then 

highlight the desired document(s).  Hold the <Ctrl> key to select multiple documents. 

The date fields automatically populate with the current date.  If you wish to use different dates, enter the 
date to override the current date in the Letter Date field.  Leaving the Signing Date blank or activating 

the Leave Blank tickbox will populate the legal date with “the     Day of <Current Month>, <Current 

Year>”.  If you prefer to post- or pre-date your legal signing date, or use a different format, insert it 
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here.  The Use Date as of field will create documents reflecting that point in time.  Directors and 

shareholders after that date will not appear on documents or reports. 

Note:  Some documents require specific conditions to generate properly, for example, the First Director 
Resolutions need the First Director Tick box activated, or gender specific documents require the 

gender to be set on the Details Tab of the Contact Card.   If names, addresses or gender are 
inaccurate, check your entries to ensure all required fields are entered. 

Packages 

Packages are a combination of documents and reports bundled together to create one comprehensive 
item. In addition to the Organization and Annuals Packages accessed by the Create Documents Quick 

Pick button, clicking on All Documents > Packages gives many more options such as a Dividend 

Package or Share Transfer Package.  For example, the Organization Package can include Directors 
Resolutions, Shareholders Resolutions, By Laws, Share Subscriptions, and Directors, Officers and 

Shareholders Registers as well as the Reporting Letter.   

Custom Packages can be setup through data maintenance.  Please see the Administration Manual for 
instructions to create Custom Packages for your firm. 
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Update Annuals and/or Registrations 

Update Annuals allows you to update the Last Annuals Filed date for one or many Matters at one time.   

Open the Corporate Files List. 

Make sure that the columns Corporation Name, Annuals Filed and Annuals Due are included in the List. 

You can sort the Corporations into date order by highlighting either the Annuals file or Annuals Due 

column and doing a Z-A sort. Select the Corporation to update the last Annuals Filed date. Use the Shift 
key or Ctrl to make multiple selections.   

 

Right-click and then select Create Document to open the New Document dialogue box.  Navigate to the 

document or Package to generate the Annuals as Word documents ready for printing for each and every 
corporation that has been selected in the list.  The created Annuals will then be added to the Documents 

Tab if the save feature is being used. 

Next, right click and select Update Annuals.  Enter the New Annuals Filed date (mm/dd/yyyy) in the 
textbox and select OK.  The Next Annuals Due Date will be calculated based on jurisdiction 

 

Remember to Refresh the Corporation File List to view the updates. 
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Saving a Document 

As discussed in the Documents Tab section, Corporate Manager ET has document management built into 
the application.  If you selected Save in the Document Options, the document is automatically saved 

in the location specified on the Administration Tab and a link created on the Documents Tab.  By clicking 
on the blue link, the document will open.  Any User with Corporate Manager ET on their system will be 

able to retrieve documents saved by other Users.  In addition, the Documents Tab provides an exact 

history of what documents already created for this matter.  The name of the document will also be added 
to the Workflow Tab for tracking and follow-up.  

 

Options   

Select the Options button from the Document Window to set further options for the documents. For 

example, you may wish to automatically Save, Print and Close the document(s) once they are created 

and add a follow up task.  When all choices have been made, click OK to generate the documents to 
Word.  You can also choose to make these choices your default choice so that these actions are 

performed for all documents created in Corporate Manager at that workstation. 
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Chapter 7: Lists 
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Using Lists 

Opening Matters 

From the Toolbar, select Open Last File and Corporate File or Contact.  Or select File from the top 

menu and a list of recently opened Matters and Contacts will be available for selection.   

       

Type all or part of the name in the Search Box on the Toolbar and Enter.  If there is only one Matter 

containing the name, it will open.  If there are more than one, click the dropdown arrow to see the 
search results and make your selection. 

 

Finding Contacts or Matters in Lists 

Searching for Matters is easy using the Corporate File List.  After clicking the Corporate Files button on 

the Toolbar, a list of all open Matters and other related information will appear.  To search for a 

corporation, simply highlight the Corporate Name column heading and type part or the entire name 
that is being searched.   

NOTE:  There is no start or stop button for this search feature.  After you finish typing, the database will 
be searched for all matches to the text just entered.  Toggle the Search On/Off button to clear the 
search results. 

 

Double Click on the corporation name to open the Matter. 

To open the list of corporate files, select the Corporate Files button on the Toolbar.  All other Lists are 
available by selecting View > Corporate and the appropriate List. 
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Sorting Lists by Columns 

Users can also sort Lists alphabetically within the various columns shown. For example, to sort 
the Contact List by the city field, simply click on the City column header until it turns blue, then 

click on the Sort buttons to sort alphabetically in ascending  or descending  order. 

Finding Matters using Search 

Quickly limit a list of Matters by using the Search feature.  Select the desired field to be searched and 
enter your search term.  Choose OK and the appropriate List will open already filtered with suggested 

files. 
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Matters List 

 

This List accessed by View > Matters and is driven by the File Status dropdown menu on the 

Administration Tab and you can view Matters by Open, Closed, Inactive, Draft and Pending. 

Note: Although both File Status and Status are fields on the Administration Tab, they are unrelated.  
File Status has a direct effect on the behavior of Matter Lists and the Billing Status of the Matter, 
whereas Status (of the corporation) is a reference field for internal firm use. 

Sorting Lists by Columns 

Users can also sort both Contact and Matter Lists alphabetically within the various columns shown. For 

example, to sort the Contact List by the city field, simply click on the City column header until it turns 

blue, then click on the Sort buttons to sort alphabetically in ascending  or descending  

order. 

Note: By design, some columns are not searchable or do not sort. 

Activities List 

The Activities button on the main toolbar displays a List of all Activities that have been entered on the 

Annuals/Activities section of the Administration/Annuals Tab for all Matters.  By sorting the columns the 

user can display, for example, all extra-provincial registrations.  By creating a custom search using the 
Advanced Searches Filter, the user can display all extra-provincial registrations in Alberta with a renewal 

date of November, 2020 or any other variation of search fields.   

Add/Remove/Reorder List Columns 

 

Emergent Lists are completely customizable to fit your needs and retains your preference settings specific 
to your computer.  You can organize the List to provide the most important information where you want 

it to be for quick viewing.  

Columns can be added, moved or removed from a List to customize the information on the 
screen.   To add or remove a column, select the Insert Column or Remove Column buttons 
respectively (use the Control key to make multiple selections) and then click the small blue 
Insert Column button or the Remove Column button.   
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To remove a column, highlight the column you want to remove by clicking on its title. Click the 
Remove Column button.  

Highlight the column you want to move by clicking on its title. Click the column heading a 
second time and hold your mouse button. The column heading will look detached from the 
column.  Drag the column to the desired position and drop it in place by releasing your mouse 
button 

To move a column, highlight the column you want to move by clicking on its title, then click and 
hold the column heading a second time.  The column heading will look detached from the 
column.  Drag the column heading to the desired position and drop it in place by releasing your 
mouse button.  

Changing Fonts in List Columns 

 

Select the Format Grid button on the List Toolbar.   

To change the background colour of a list, select Back Colour and select a colour.  This feature can let 
you easily tell one list from another. 

To change the font size or syle, select Font and choose the size and/or style of font.   

Resetting a List 

To reset a List, hold the shift key while opening the List. This will reset the background colour and font 
changes, and remove all columns and prompt you to select new ones.    



 

 
Corporate Manager ET User Guide 

 

 

113 
 

Saving and Printing List Reports 

Printing List Reports 

Customized lists can be easily printed by simply selecting the Print button from the List Toolbar.  At this 

point the Page Setup window appears. Here you can set paper size, orientation, margins, etc. When you 
are ready to print, click OK. The list will be sent to your default printer.  All columns in the List will print.  

If it is a large list or has many columns it may spread across many pages.  In that case, Save and Print 
the List as set out in Saving and Printing Lists Reports. 

Saving and Printing List Reports 

List reports can be saved as an HTML file, and once saved, they can be emailed as an attachment or 
used in a Word Mail Merge.  They can also be imported to Excel for printing or other uses. 

 Step One 

Open the Filelist and ensure all columns are contained in the List.  If not, add more columns using the 

Insert Column button and selecting the new columns to be added.  Ctrl+click to select multiple 
columns. 

 Step Two 

Click Save to File  and save in the proper location.  Leave the “type” as HTML 
Document as this format is the most versatile.  Note: Save the file to the desktop to easily find in the 
next step.  

 Step Three 

Open Excel, and to open a new worksheet, chose Browse and navigate to the saved HTML file, double-
click to select and open.  

The list can now be printed from Excel. 

Deleting and Retrieving Matters or Contacts 

Although we talk about “deleting” a Contact Card or a Matter, it’s never really deleted.  It’s just 
hidden from sight so it doesn’t clutter up your Lists.  Delete a Matter by highlighting the desired 
Matter and clicking the Delete button on the Toolbar on the Corporate Files List and confirming 
the deletion.  It is then placed in the Deleted Matters List section of the Matter List.   

To delete a Contact Card, use the Inactive tickbox on the Details tab. 
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To retrieve a deleted Contact Card or Matter, click on the Contact or Matter List and change the 

dropdown menu to show Deleted Contacts or Deleted Matters.   

Open the Contact Card, go to the Details Tab and uncheck the Inactive box.   

Double clicking on the Matter on the Deleted Matters list will return it to the Open or Closed Matters list.  

 Matters List 

 

This List is accessed by View > Matters contains all Matters in Emergent, whether Corporate 
or Estates and is driven by the File Status dropdown menu on the Administration Tab. 

Advanced Searches – Creating a Customized Search 

Corporate Manager ET allows you to create your own customized searches and list them on a dropdown 
menu for quick and easy access.  Searches are useful for narrowing a particular List down to items to 

meet specific requirements. To create a customized Search, open the List of your choice.  When selecting 
a List, keep in mind that different Lists have different columns to select.   

Let’s create a search that will sort your List for all Corporations with an Ontario Jurisdiction and Year End 

of January.  In this case we will select the Corporate Files List from the main Toolbar. 

On the open Corporate File List Toolbar, click the arrow beside the Advanced Searches button and 
select New Advanced Filter.   
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The List Search window appears.   

 

Enter the name for your customized search in the Filter field.  Uncheck the Enter SQL box and change 
the Tab from SQL to Items tab.  In the Field box, make your selection in the dropdown the column to 

be searched.  Note: When applying a search to a particular column, i.e. Jurisdiction, make sure you have 
added the column for Jurisdiction in your List.    

 

In the Opr field, select the symbol for the search you would like to create.  

 

The meanings for the symbols available in the operator field are the following:  

=   - equal to       <>   - does not equal  

>   - greater than      Like   - similar to (used for text data fields) 

<   -  less than   

Note: When searching text, it is recommended you use “like” instead of “=” since “=”” specifies an exact 
match. 

Enter the value for the search in the Value field.  These can be words, dates or numbers, however, 
when searching a number column such as Incorporation Date, it’s best to use the short form of months 

(“Sept” instead of “09” as your results will return both “September” and “2009”). 
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In the And/Or field, select which statement is appropriate for your search.   

For our example, your final search terms would look like this: 

 

To translate what our search above says: Find all corporate files with a Jurisdiction of Ontario, and with a 

Year End Month of January.  

You can sort by more than one criteria by adding the desired Fields and Values on the next lines.  Once 

you have entered all the criteria for the search, select the Apply button.  Check the List to confirm your 
search is correct, then select OK.  Your customized search name will now appear on the dropdown list.   

 

The next time you want to use this Search, simply click on the Search Name on the dropdown list.   

To delete or edit an Advanced Search, slow-click the Advanced Searches button until the window 

appears, and select the Search Name to edit or click the red X beside the name to delete the Search. 
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Chapter 8: Tasks and Reports 
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Workflow 

The Workflow task reminder system is an integrated task management tool within Corporate Manager ET. 

Users are assigned tasks that populate Reminder Reports to manage the processing of Matters. 

Create or Add a Task 

There a number of ways to create or add a task. 

Associate the Task with a Matter.  For example, when you are creating a new Extra Provincial 

Registration which will expire in three years, you can elect to create a reminder: 

 

You can also manually add a New Task by clicking on the Add a Task button on the Toolbar and enter 

the necessary information, such as Due Date and Priority.  Tasks can be assigned to a particular person 
by using the Assigned To dropdown, and if necessary, clicking the Action link will display the Create 

Document form so that the required document can be selected.  If the Add Follow Up Task tickbox is 

selected, the task will appear on the Follow-Up section of the Workflow tab.  

 

You can navigate to the Task section in the Workflow Tab and click on the  and choose New Task, or 
click on the Add a Task button. 

 



 

 
Corporate Manager ET User Guide 

 

 

119 
 

Adding a Task from within a Matter will automatically associate the Task to the Matter, or you can delete 

the Corporation Name in the task window to create a general Task not linked to any given Matter.   

An unlimited number of Tasks can be assigned to a Matter. Tasks can be made private by selecting the 
Mark Task Private checkbox during the creation of the task.  A Private Task will only appear on your 
Task List – it will not be accessible to any other users and will not appear on the All Users Task List. 

Completing a Task 

To mark a Task Completed on the Task List, click on the  and set the Status to Completed.  

Editing a Task 

A Task can be edited by clicking on the , selecting Edit, making the necessary changes, and clicking 
Save and Close. 

Removing a Task 

If the Task is not associated with a Matter, generate the Reminder Report and double-click on a selected 
Task to open.  It can be deleted by selecting the Remove Task button on the Task Toolbar. 

To remove a Task from the Task List on the Workflow Tab of a particular corporation, click on the  

and click Remove.  

Tasks and Reminders Lists 

Once a Task has been added it will appear on the Reminder Report and on the Tasks/Reminders List.  

Depending on your settings, the Reminder Report may open each time you open Estate Planning & Vault 
Manager, or it can be opened using the Reminder Report button.  All Tasks and Reminders can be 

viewed by clicking the All Users button. 

 

You can also view all Tasks and Reminders by View > Tasks/Reminders.  
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Reminder Report 

Once a Task has been added it will appear on the Reminder Report and on the Tasks/Reminders List.  
Depending on your settings, the Reminder Report may open each time you open Corporate Manager ET, 

or it can be opened using the Reminder Report button.  All Tasks and Reminders can be viewed by 
clicking the All Users button. 

 

Open Matters and Tasks 

Double Click on the Task row to open and update a Task item, or double click on the corporate name to 
open the associated Matter. 

View Tasks 

View Tasks for all users or your own tasks by toggling the button between My Tasks or All Tasks. 

Only Show the next 2 month(s) 

The Task report will display all upcoming tasks for the next two months.   

Hide Completed Tasks 

Completed Tasks are removed from the task list.  They can be viewed by removing the checkmark next 
to Hide Completed Tasks.  

Adjusting Columns in Reminder Report 

All columns can be adjusted by placing the cursor between headings and changing the width when the 

cursor appears as a two-sided arrow. 

Sorting tasks 

Tasks can be sorted by right-clicking a column heading.  Select the order for the report to be sorted. 

Find a Company in the Task List 

Right-click on the Corporation Name column and select Find.  Enter the company name to find. 

Printing Task Reports 

Task Reminder Reports can be printed by selecting the print icon.  To display a list of only today’s tasks, 

select Print today’s tasks. 
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Chapter 9: Advanced Options 
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Application Startup Options 

Corporate and Estate Manager ET can be customized to start the program with your preferred view   

Select Tools > Options > Application and select from the dropdown list. In this location you can 

define the List that will appear at start up, as well as whether the Reminder Report will open.  These 

Options are specific to the workstation computer and will not affect the settings of other users in the 
firm. 

 

 

 Start with a file (the last opened file) 

 Start with the Corporate Listview 

 Start with the Corporate Records Listview 

 Start with Estate Planning Listview 

 Start with Probate Files Listview 
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Turn Reminder report off during Application Startup 

Select Tools > Options > Application and select from the drop down list. In this location you can 
define whether the program will start with the last file worked on or a List will appear at start up These 

Options are specific to the workstation computer and will not affect the settings of other users in the 
firm. 

The Reminder Report appears when Corporate Manager ET is opened.  If this is not needed, uncheck the 

Show Reminder Report tickbox. 

It is not recommended to deactivate the Show Popup Notes because of the potential of missing 
important information. 

Reactivating Location of Corporate Records Wizard 

When Share transactions are completed, the Location of Corporate Records Wizard will appear so that 
the location of the Share Certificate can be recorded.  Once the Don’t show This Form Next Time tickbox 

is checked, this form will not show again on that specific computer.  It can be turned on again by going 

to Tools > Options > Application and reactivating the check mark next to Show Location of 
Corporate Records Wizard. 

 

Closing Matters/Viewing Closed Matters 

As time progresses, a Corporate Matter may become inactive, whether by Dissolution or the client taking 

their files elsewhere. Although you have the option of deleting Matters, you may still want to reference 
them from time to time.  

It is recommended that you set these Inactive Matters as Closed. This way you can still access them if 

required, but they will not clutter up your Lists of current Matters.  Once a Matter is closed, the Common 
Tasks and Create Documents are deactivated. 
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To close a Corporate Matter, select Closed from the File Status dropdown list on the Administration Tab.  

This will also stop the Emergent billing process for this particular Matter. 

You also have the option of entering a Reason for Closing, Closed Date and a Closed File Number. 

 

Deleted Matters 

Delete a Matter by highlighting the desired Matter and clicking the Delete button on the Toolbar on the 
Estate Planning List or Probate List.  It is then placed in the Deleted Matters List section of the Matter 

List. To retrieve a Matter from the Deleted List, double-click on a Matter to open it and set the File 

Status to Open on the Administration Tab to return it to the active Matter list. 

Update Saved Document Folder Locations 

It may be necessary to change the folder name for saved documents in custom folder locations.  First, 

change the name of the current folder.  To then update all saved documents for this matter, follow one 
of these two steps: 

On the Administration/Annuals Tab at the text window for Where do you want to save 

documents? Click on  and point to the new folder. 

 

OR 

In the Created Documents Tab, click on   any document row and select change folder. 
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Point to the renamed folder. 

Confirm that the information is correct and choose OK to update the document path. 

 

Research 

Corporate Manager ET provides easy access to the Research sites you use most.  Click the Research 
button on the Toolbar and the browser will open to the chosen search site.  There is no need to leave 

Corporate Manager ET to open a browser window. 

 

Adding items to this list is done through Tools > Data Maintenance > Matter > Research.   
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Add the following Values in the corresponding fields: 

Description – The text that best describes this website. 

Link – The link to this website. NOTE:  The link must begin with http:// 

Sort Order – Determines the order in which these items are displayed in the list. 

Note:  The Research links are available across all practice areas, which means all users have access to 

and will be updated with the same Research links. 

Search Online 

 

Corporate Manager ET also provides quick access to your most used online provincial search engines.  

There is no need to leave Corporate Manager ET to open a browser window. Click the Search Online 
button and the browser will open to the chosen search site.  

Creating a Mail Merge from Lists 

Choose the List that the Mail Merge will be created from.  The Corporate Client Contact List will be used 
for demonstration purposes. 

1. View > Corporation > Client Contact to open the list.  View > Probate > Trustee, View > 
Probate > Estate Planning > Representative or the Estate Planning File Lists can also be 
used. 

4.  
2. Ensure the required columns are contained in the list.  In this case, the Corporation 

Name, the Client Contact and the Full Address columns. 
3. Choose any or all the Corporations to be included in the mail merge. 
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5.  

4. Click Save to File  and save as HTML.  Saving as an HTML file is the 
most versatile format.  There is no need to convert to Excel or a CSV file. 

The most common use of the Mail Merge feature is mass mailings to a client list, whether an annual 

information bulletin or to advise of new legislative requirements.  Most firms also have an existing style of 
mailing labels with logos and return address.  Before beginning the mail merge, either draft the 
correspondence or open the mailing labels. 

1. Next, choose Mailings from the Toolbar or Toolbar Ribbon to start the Mail Merge.    

6.  
7. On the Start Mail Merge dropdown, select the starting document.  If Labels is the 

starting document, there will be a further step to choose the type of labels.  Click OK 
and then Cancel.  This triggers the proper actions for the next steps in creating the 
labels. 

2. Click on Select Recipients and choose Use an Existing List and then Browse to the 
saved HTML file and select for use. 

8.      
3.  Click Edit Recipient List to edit any duplicates, etc. 

9.  
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4. Next, add the fields that will be used for the Mail Merge.  Click Insert Merge Field to 
display the columns included from the Client Contact List.   

10.    

 
5. When satisfied with the spacing, fonts and layout of the labels, click Update all Labels to 

create a full page of individual labels.* 

11.     
6. You can then preview by clicking Preview Results, which will display the end result, either 

the correspondence or, if a full page of mailing labels, the first page.  This allows you to 
check that the merge fields and formatting are correct. 

12.  

13.  
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7. When the results are satisfactory, click on Finish & Merge and select Edit Individual 
Documents.  The final choice is whether to merge all matters or a selection 

14. 

 
8. The end result will be the merged document for final editing and printing. 
*Note:  if the logo and return address are in separate cells from the merge fields, use the following 
procedure: 

As in step 4 above, select the merge fields and arrange the label formatting.  When satisfied, click 

Update Labels.  You will note NEXT RECORD appears in the logo/return address cell of each label.    

 

15. Copy and paste the merge fields into the blank cells.  Continue with step 6 above.  
16.  


